
  

 

 
 
 
 
 
  

 

  
  
 
  

 

   

 

 

 
 

The smart way to learn
Microsoft Outlook 2013

—one step at a time!

Experience learning made easy—and quickly teach yourself 
how to create your own database with Microsoft Access 2013. 
With Step by Step, you set the pace—building and practicing 
the skills you need, just when you need them!

Cox
Lambert

• Build a custom database from scratch or templates
• Create forms to enter, edit, and display data
• Write queries to extract and manipulate data
• Import data from other databases and documents
• Design, run, and print reports, and add subreports
• Help prevent data corruption and unauthorized 

access

Your Step by Step digital content includes:
• All the book’s practice files—ready to download at: 
http://aka.ms/Access2013sbs/files
• Fully searchable ebook. See the instruction page at 

the back of the book.

M
icrosoft O

utlook 2013

Follow the easy numbered steps 

Use screenshots to check your work

Get helpful tips and pointers

Build your skills hands-on with 
ready-made practice files
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Build exactly the skills you need. 

Learn at the pace you want.
 

Microsoft 
Outlook 2013 

Joan Lambert and Joyce Cox 
Practice files 
plus ebook 



PUBLISHED BY
Microsoft Press
A Division of Microsoft Corporation
One Microsoft Way
Redmond, Washington 98052-6399

Copyright © 2013 by Joyce Cox and Joan Lambert

All rights reserved. No part of the contents of this book may be reproduced or transmitted in any form or by any 
means without the written permission of the publisher.

Library of Congress Control Number: 2013931602
ISBN: 978-0-7356-6909-3

Printed and bound in the United States of America.

Second Printing

Microsoft Press books are available through booksellers and distributors worldwide. If you need support related 
to this book, email Microsoft Press Book Support at mspinput@microsoft.com. Please tell us what you think of 
this book at http://www.microsoft.com/learning/booksurvey.

Microsoft and the trademarks listed at http://www.microsoft.com/about/legal/en/us/IntellectualProperty/
Trademarks/EN-US.aspx are trademarks of the Microsoft group of companies.  All other marks are property of 
their respective owners.

The example companies, organizations, products, domain names, email addresses, logos, people, places, and 
events depicted herein are fictitious. No association with any real company, organization, product, domain name, 
email address, logo, person, place, or event is intended or should be inferred.

This book expresses the author’s views and opinions. The information contained in this book is provided without 
any express, statutory, or implied warranties. Neither the authors, Microsoft Corporation, nor its resellers, or 
distributors will be held liable for any damages caused or alleged to be caused either directly or indirectly by 
this book.

Acquisitions Editor: Rosemary Caperton
Editorial Production: Online Training Solutions, Inc. 
Technical Reviewer: Rob Carr 
Copyeditor: Jaime Odell 
Indexer: Jan Bednarczuk 
Cover: Microsoft Press Brand Team

[LSI]
[2013-09-06]



	 Contents      iii

Contents
Introduction  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . xi

Who this book is for . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              xi
How this book is organized . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       xi
Download the practice files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                        xii
Your companion ebook . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          xiv
Get support and give feedback  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   xiv

Errata . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                 xiv
We want to hear from you  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               xv
Stay in touch  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           xv

PART 1

Basic skills
	 1	 Get started with Outlook 2013	 3

Sidebar: Outlook Web App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                5
Identifying new features of Outlook 2013  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           6
Connecting to email accounts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     8

Sidebar: Adapting exercise steps  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          11
Troubleshooting connection problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             20

Connecting to Exchange accounts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        20
Connecting to Internet email accounts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    21

Working in the Outlook 2013 user interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        24
Working with the ribbon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 27
Working in the Backstage view  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           32

Getting help with Outlook 2013 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   33
Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                      37



iv      Contents

	 2	 Explore Outlook 2013	 39
Working in the Outlook program window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          40

Program window elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               40
Navigation Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         42

Working in the Mail module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      45
Folder Pane content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     46
Content area views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      48
The ribbon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             49
Message windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      50

Working in the Calendar module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  65
Calendar module content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                65
Calendar item windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  68

Working in the People module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    73
People module content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  73
Contact record windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 75

Working in the Tasks module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     81
Tasks module content  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   81
Task windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           83

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                      85

	 3	 Send and receive email messages	 87
Creating and sending messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   88

Addressing messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    88
Troubleshooting message addressing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      91
Entering content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                        93
Saving and sending messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            94

Attaching external content to messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           103
Sidebar: Managing multiple accounts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     104
Sidebar: Working with new mail notifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              106
Sidebar: Troubleshooting file types and extensions  . . . . . . . . . . . . . . . . . . . . . . . . .                         107

Viewing messages and message attachments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      108
Viewing conversations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  112
Viewing content in the Reading Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     112



	 Contents      v

Viewing message participant information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         119
Presence icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         119
Contact cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         119
The People Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       121
Sidebar: Troubleshooting the People Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                123

Responding to messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                        123
Sidebar: Resending and recalling messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                130

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     131

	 4	 Store and access contact information	 133
Saving and updating contact information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         134

Creating contact records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                135
Address books . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         136

Communicating with contacts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   146
Initiating communication from contact records  . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            146
Sidebar: Conforming to address standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                147
Selecting message recipients from address books . . . . . . . . . . . . . . . . . . . . . . . . . .                          148

Displaying different views of contact records  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      149
Sidebar: User-defined fields  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             156

Printing contact records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         157
Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     165

	 5	 Manage scheduling	 167
Scheduling and changing appointments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          168

Sidebar: Adding national and religious holidays to your calendar . . . . . . . . . . . . .             174
Sidebar: Creating an appointment from a message . . . . . . . . . . . . . . . . . . . . . . . . .                         176

Scheduling and changing events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 177
Scheduling meetings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           178

Sidebar: Updating and canceling meetings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                185
Responding to meeting requests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 186
Displaying different views of a calendar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           189

Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                 189
Arrangements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         190
Using the Date Navigator  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               191

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     197



vi      Contents

	 6	 Track tasks	 199
Creating tasks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                 200

Creating tasks from scratch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             201
Creating tasks from Outlook items  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       202

Updating tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                 210
Removing tasks and flagged items from task lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  212
Managing task assignments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     214

Tasks you assign to others . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               214
Tasks other people assign to you . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         216

Displaying different views of tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                219
Sidebar: Finding and organizing tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    226

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     227

PART 2

Content management
	 7	 Organize your Inbox	 231

Working with Conversation view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 232
Viewing conversations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  233
Conversation view settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              234
Managing conversations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                236
Sidebar: Troubleshooting Conversation view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               237

Arranging messages in different ways . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             237
Sidebar: Marking messages as read or unread  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             244

Organizing items by using color categories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        244
Sidebar: Recording information by using Outlook notes . . . . . . . . . . . . . . . . . . . . .                     252

Organizing messages in folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  253
Managing messages by using Quick Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         257



	 Contents      vii

Quickly locating messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      262
Sidebar: Using Search Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            264
Sidebar: Deleting messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             265

Printing messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              268
Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     273

	 8	 Manage your calendar	 275
Defining your available time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     276
Configuring time zones  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         280

Sidebar: Specifying appointment time zones . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              281
Working with multiple calendars . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 282

Displaying a co-worker’s calendar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        284
Connecting to Internet calendars  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        284

Sharing calendar information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    290
Sharing calendars with co-workers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       290
Sharing calendar information outside of your organization . . . . . . . . . . . . . . . . . .                  294

Printing a calendar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             297
Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     307

	 9	 Manage contact records	 309
Creating address books . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         310
Importing and exporting contact records  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         315
Creating contact groups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                        325
Quickly locating contact information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             332

Sidebar: Sending business cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         336
Personalizing electronic business cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            337
Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     343



viii      Contents

	 10	 Enhance message content	 345
Personalizing the appearance of message text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     346

Configuring message text formatting preferences . . . . . . . . . . . . . . . . . . . . . . . . . .                          346
Manually formatting message text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       352
Configuring message signature preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               353

Inserting and modifying images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .361
Inserting pictures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      361
Sidebar: About online pictures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           363
Inserting shapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       364
Inserting screen images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 366

Creating and formatting business graphics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        381
Changing message settings and delivery options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   390
Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     393

PART 3

Program management
	 11	 Customize Outlook	 397

Personalizing the Outlook program window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       398
Configuring Office and Outlook options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          403

Configuring Mail module options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        404
Configuring Calendar module options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    415
Configuring People module options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      418
Configuring Tasks module options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       418
Configuring search options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              419
Configuring language options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           421
Configuring advanced options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           422

Customizing the Quick Access Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            427
Customizing the ribbon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         433

Sidebar: Customizing the status bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      439



	 Contents      ix

Managing add-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             440
Sidebar: Creating Outlook forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         442

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     443

	 12	 Manage email settings	 445
Creating and managing Quick Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              446
Creating rules to process messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               451
Blocking unwanted messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    459

Working with junk email messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       459
Configuring junk email options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          463

Increasing email security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                        467
Digital signatures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      467
Encryption  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            474
Plain text messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    475
Information Rights Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         475
Blocking external content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               476

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     477

	 13	 Work remotely	 479
Working with Outlook items while offline  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         480

Choosing to work offline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                481
Using public folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    482
Setting Cached Exchange Mode options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  485
Managing an offline address book  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       486

Managing download options for slow connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 489
Automatically replying to messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              491
Working with SharePoint site content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             498

Working offline with document library content  . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            499
Importing SharePoint contact lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       503
Connecting to a SharePoint calendar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     505

Key points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                     507



x      Contents

Glossary .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 509

Keyboard shortcuts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 517

Outlook 2013 keyboard shortcuts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  517
Create Outlook items or files  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 517
Navigate in Outlook .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 518
Use the Outlook Backstage view .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 519
Locate Outlook items .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 519
Manage Outlook items  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 519
Manage and format item content .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 520
Work with the Mail module and email messages .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 521
Work with the Calendar module and calendar items .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 522
Work with the People module and contact records .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 523
Work with the Tasks module and tasks .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 525
Send and receive information . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 526
Use development tools  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 527

Office 2013 keyboard shortcuts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  527
Display and use windows . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 527
Use dialog boxes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 527
Undo and redo actions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 529
Navigate the ribbon .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 529
Move around in text or cells .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 529
Move around in and work in tables . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 530
Access and use panes and galleries .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 530
Access and use available actions  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 530
Find and replace content (when editing)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 531
Use the Help window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 531

Index . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 533

About the authors  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 557



	 Introduction      xi

Introduction
Part of the Microsoft Office 2013 suite of programs, Microsoft Outlook 2013 is a sophisti-
cated communication-management program that helps you quickly and efficiently manage 
messages, schedules, address books, and other information. Microsoft Outlook 2013 Step by 
Step offers a comprehensive look at the features of Outlook that most people will use most 
frequently.

Who this book is for
Microsoft Outlook 2013 Step by Step and other books in the Step by Step series are designed 
for beginning to intermediate-level computer users. Examples shown in the book generally 
pertain to small and medium-sized businesses but teach skills that can be used in organi-
zations of any size. Whether you are already comfortable working in Outlook and want to 
learn about new features in Outlook 2013 or you are new to Outlook, this book provides 
invaluable hands-on experience so that you can manage communications and information 
with ease.

How this book is organized
This book is divided into three parts. Part 1 explores the everyday experience of working in 
Outlook 2013. Part 2 discusses ways of managing content within Outlook to maximize your 
productivity. Part 3 delves into the management of Outlook itself, and ways of customizing 
program functionality and the appearance of the program window to fit the way you work. 
This three-part structure allows readers who are new to the program to acquire basic skills 
and then build on them, whereas readers who are comfortable with Outlook 2013 basics 
can focus on material that is of the most interest to them.

Chapter 1 contains introductory information that will primarily be of interest to readers who 
are new to Outlook or aren’t familiar with the process of configuring Outlook to connect to 
an email account. If you are comfortable managing accounts in a recent version of Outlook, 
you might want to skip directly to Chapter 2.
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This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform with Outlook 2013. If you start at the beginning and work your 
way through all the exercises, you will gain enough proficiency to be able to manage com-
munications, contacts, tasks, and calendars. However, each topic is self-contained, so you 
can jump in anywhere to acquire exactly the skills you need.

Download the practice files
Before you can complete the exercises in this book, you need to download the book’s prac-
tice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/Outlook2013sbs/files

IMPORTANT  The Outlook 2013 program is not available from this website. You should 
purchase and install that program before using this book.

As you work through the exercises in this book, you will create Outlook items that you will 
use as practice files in later exercises. If you do not complete the earlier exercises, you can 
substitute Outlook items of your own and modify the exercise settings to fit.

The following table lists the practice files for this book.

Chapter Use these files and items Create these files and items
Chapter 1: 
Get started with 
Outlook 2013

No practice files required None

Chapter 2: 
Explore 
Outlook 2013

No practice files required None

Chapter 3: 
Send and receive 
email messages

	We provide:
NaturalGardening.pptx
Procedures.docx

SBS First Draft message series
SBS Tradeshow Schedule message

Chapter 4: 
Store and access 
contact information

No practice files required Contact records for Ben Miller, Dean 
Halstead, Jill Frank, Lola Jacobsen, and 
Sarah Jones
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Chapter Use these files and items Create these files and items
Chapter 5: 
Manage scheduling

No practice files required SBS Lunch with Jane appointment
SBS Pay Day event
SBS Staff Meeting appointment
SBS Study Session meeting

Chapter 6: 
Track tasks

	You provide:
SBS First Draft message
SBS Tradeshow Schedule message

	Flagged SBS First Draft message
Flagged SBS Tradeshow Schedule 
message
SBS Make Dinner Reservations task
SBS Order Brochures task
SBS Send Dinner Invitations task

Chapter 7: 
Organize your 
Inbox

	You provide:
SBS First Draft message series
SBS Tradeshow Schedule message

	SBS Messages folder

Chapter 8: 
Manage your 
calendar

No practice files required Secondary calendar

Chapter 9: 
Manage contact 
records

	We provide:
JoanLambert.jpg
SBSContacts.csv

You provide:
Contact records for Ben Miller, Dean 
Halstead, Jill Frank, Lola Jacobsen, and 
Sarah Jones

	Contact records for Delphine Ribaute, 
Max Stevens, and Sara Davis
SBS Contacts address book
SBS Project Team contact group

Chapter 10: 
Enhance message 
content

	We provide:
Lighthouse.jpg

	Casual email signature
SBS Development Process message
SBS Picture Tools message

Chapter 11: 
Customize Outlook

No practice files required None

Chapter 12: 
Manage email 
settings

No practice files required Flagged SBS Quick Message message
SBS Messages folder
SBS rule

Chapter 13: 
Work remotely

No practice files required None
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Your companion ebook
With the ebook edition of this book, you can do the following:

▪▪ Search the full text

▪▪ Print

▪▪ Copy and paste

To download your ebook, please see the instruction page at the back of the book.

Get support and give feedback
The following sections provide information about getting help with this book and contact-
ing us to provide feedback or report errors.

Errata
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on 
our Microsoft Press site, which you can find at:

http://aka.ms/Outlook2013sbs/errata

If you find an error that is not already listed, you can report it to us through the same 
page.

If you need additional support, email Microsoft Press Book Support at:

mspinput@microsoft.com

Please note that product support for Microsoft software is not offered through the  
addresses above.
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable 
asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress.



Chapter at a glance

Save 
Save and update contact information,  
page 134

Display 
Display different views of contact records,  
page 149

Communicate 
Communicate with contacts,  
page 146

Print 
Print contact records,  
page 157
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Store and access 
contact information

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪▪ Save and update contact information.

▪▪ Communicate with contacts.

▪▪ Display different views of contact records.

▪▪ Print contact records.

Having immediate access to current, accurate contact information for the people you need 
to interact with—by email, phone, mail, or otherwise—is important for timely and effective 
communication. You can easily build and maintain a detailed contact list, or address book, 
in the Microsoft Outlook 2013 People module. From your address book, you can look up 
information, create messages, and share contact information with other people. You can 
also keep track of your interactions with a person whose contact information is stored in 
Outlook.

If you need to take contact information with you in a non-electronic format, you can print 
an address book or selected contact records, in many different formats.

In this chapter, you’ll create and edit contact records and view them in different ways. Then 
you’ll discover how to initiate communications with people from contact records or from an 
address book. Finally, you’ll print a contact record and a list of contact information.

PRACTICE FILES  You don’t need any practice files to complete the exercises in this chapter.
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Saving and updating contact information
You save contact information for people and companies by creating a contact record in an 
address book. 

A typical contact record for a business contact.

TIP  You can create a personalized electronic business card for yourself or for any of your 
contacts. For information, see “Personalizing electronic business cards” in Chapter 9, 
“Manage contact records.”
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On the General page of a contact record, you can store the following types of contact 
information:

▪▪ Name, company name, and job title

▪▪ Business, home, and alternate addresses

▪▪ Business, home, mobile, pager, and other phone numbers

▪▪ Business, home, and alternate fax numbers

▪▪ Webpage address (URL), instant messaging (IM) address, and up to three email 
addresses

TIP  If you need to store more than three email addresses for a contact, you can do 
so by creating a custom contact record form.

▪▪ Photo, company logo, or other identifying image

▪▪ General notes, which can include text and illustrations such as photos, clip art images, 
SmartArt diagrams, charts, and shapes

On the Details page of a contact record, you can store personal and organization-specific 
details, such as the following:

▪▪ Professional information, including department, office location, profession, manager’s 
name, and assistant’s name

▪▪ Personal information, including nickname, spouse or partner’s name, birthday, anni-
versary, and the title (such as Miss, Mrs., or Ms.) and suffix (such as Jr. or Sr.) for use 
in correspondence

Creating contact records
You typically create a contact record by displaying the address book to which you want to 
add the contact record in the People module and then clicking the New Contact button in 
the New group on the Home tab. In the contact record window that opens, you insert the 
information you want to save. After you save the contact record, it appears in the contact list.

You can create a contact record that contains only one piece of information (for example, a 
name or company name), or as much information as you want to include. You can quickly 
create contact records for several people who work for the same company by cloning the 
company information from an existing record to a new one. And of course, you can add to 
or change the information stored in a contact record at any time.
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The order in which Outlook displays contact records in the contact list is controlled by the 
File As setting. By default, Outlook files contacts by last name (Last, First order). If you pre-
fer, you can change the order for new contacts to any of the following:

▪▪ First Last

▪▪ Company

▪▪ Last, First (Company)

▪▪ Company (Last, First)

To set the filing order for all your contacts, display the People page of the Outlook Options 
dialog box, click the Default “File As” Order arrow and select an order from the list. You can 
change the filing order for an individual contact by selecting the order you want in the File 
As list in the contact record.

TIP  In addition to creating individual contact records, you can create groups of contacts so 
that you can manage messaging to multiple people through one email address. For infor-
mation, see “Creating contact groups” in Chapter 9, “Manage contact records.”

Address books
Outlook stores contact information from different sources in separate address books. Some 
are created by Outlook, some by your email server administrator, and others by you.

Contacts address books
Outlook creates a Contacts address book for each account you connect to. These address 
books are available from the My Contacts list in the Folder Pane of the People module.

The Folder Pane of the People module displays a list of all your address books.

The Contacts address book of your default email account is your main address book, and 
it is the address book that appears by default in the People module. The Contacts address 
book is empty until you add contact records to it. 
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Custom address books
You can create address books in addition to those associated with email accounts; for 
example, you might want to keep contact information for family and friends in an address 
book separate from client contact information, or you might maintain an address book for 
clients that meet specific criteria. 

You create an address book by creating a folder and specifying that the folder will contain 
contact items. 

An address book is a folder designed specifically  
to contain contact records and contact groups.

When you display the Folder List in the Folder Pane, your custom address books appear 
along with other folders you create, and you can organize them in the same manner—
for example, at the same level as your Inbox, as a subfolder of the Contacts address 
book, or inside a project folder. All address books are available from the My Contacts list 
in the Folder Pane of the People module.

SEE ALSO  For information about creating address books, see “Organizing messages in  
folders” in Chapter 7, “Organize your Inbox.”

TIP  If your organization stores contact information in a SharePoint contact list, you can 
import the list contents from SharePoint into Outlook as an address book. For more infor-
mation, see “Working with SharePoint site content” in Chapter 13, “Work remotely.”
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Global Address Lists
If you have a Microsoft Exchange Server account, you also have access to an official address 
book called the Global Address List (or GAL). The GAL is maintained by your organization’s 
Exchange administrator and includes information about individuals within your organiza-
tion, distribution lists, and resources (such as conference rooms and media equipment) that 
you can reserve when you schedule meetings. It can also include organizational information 
(each person’s manager and direct subordinates) and group membership information (the 
distribution lists each person belongs to).

The GAL doesn’t appear in the My Contacts list shown in the Folder Pane of the People 
module. To display the GAL, click the Address Book button in the Find group on the Home 
tab of the People module or the Address Book button in the Names group on the Message 
tab of a message composition window. Outlook users can view the GAL but not change its 
contents. Only an Exchange administrator can modify the GAL.

In this exercise, you’ll create and edit a contact record in your main address book. 

	SET UP  You don’t need any practice files to complete this exercise. Display the People 
module, and then follow the steps.

1	 On the Home tab, in the New group, click the New Contact button to open a new 
contact record window.

2	 In the Full Name box, enter Sarah Jones, and then press the Tab key to move the 
cursor to the Company box. Notice that Outlook transfers the name to the File as 
box, and displays it in the default order (Last, First). The name also appears on the 
contact record window title bar and in the business card representation.

SEE ALSO  For information about changing the default order, see “Configuring Office 
and Outlook options” in Chapter 11, “Customize Outlook.”

3	 In the Company box, enter Wingtip Toys.

4	 In the Job title box, enter Creative Design Manager.

5	 In the Internet area of the form, enter sarah@wingtiptoys.com in the E-mail box, 
and press Tab. Notice that Outlook formats the email address as a hyperlink and 
enters the name and email address in the Display as box. This box indicates the way 
the contact will appear in the headers of email messages you exchange with this 
contact.
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6	 In the Display as box, select the email address inside the parentheses and replace it 
with the designator work.

7	 Click the E-mail arrow (not the button) to display a list of the email address fields 
available in the contact record.

Groups of related contact information fields are indicated by an arrow button to the right of the 
field name.

8	 In the E-mail list, click E-mail 2 to change the displayed email address and display 
name.

9	 In the E-mail 2 field, enter sarah@thephone-company.com, and then press Tab 
to populate the Display as field with information for this email address. Although the 
field name doesn’t change to indicate it, this information is specific to the E-mail 2 
field.

10	 In the Display as box, select the email address inside the parentheses and then enter 
personal. Notice that the business card representation in the upper-right corner of 
the contact card displays both email addresses, but not their labels.

11	 In the Web page address box, enter www.wingtiptoys.com. Outlook formats the 
URL as a hyperlink.

12	 In the Phone numbers section of the form, enter 9405550140 in the Business box, 
and then press Tab. Notice that Outlook formats the string of numbers in standard 
telephone number format.

13	 In the Addresses area, click in the text box to the right of Business, enter 315 
Wingtip Way, press the Enter key, and then enter Highflying, TX 71234.
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TIP  In a new contact record, a selected check box to the left of the Business address 
field indicates that it is the default mailing address for the contact.

14	 Click the Business arrow to display the list of address labels, and then click Home to 
indicate the address information you want to enter.

15	 In the text box, enter 111 Magnolia Lane, press Enter, and then enter Flower Hill, 
TX 71235. The contact record now contains both business and personal contact 
information.

TIP  If you enter multiple addresses for a contact and want to specify one as the 
default mailing address, display that address and then select the This Is The Mailing 
Address check box.

SEE ALSO  For information about adding an image to a contact record, see “Personal-
izing electronic business cards” in Chapter 9, “Manage contact records.”

The completed contact record.
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16	 On the Contact tab, in the Actions group, click the Save & Close button to close the 
contact record window. The contact list now includes the new contact record for 
Sarah Jones, shown in the default People view.

A People card view of the new contact record is visible in the contact list.

17	 In the contact list, double-click the entry for Sarah Jones to open the People card 
that contains her information. This card format is new in Outlook 2013; it cleanly 
displays the available information exactly as it appears in the Reading Pane.

TIP  You can assign follow-up flags to contact entries, and link contact entries to 
email messages, appointments, tasks, and other Outlook items. For more informa-
tion, see “Creating tasks” in Chapter 6, “Track tasks.” You can open a contact record in 
the original multipage contact record window by first displaying the People module 
in a view other than People view, and then double-clicking the contact record. You 
can view all items linked to a contact on the Activities page of the contact record 
window.

18	 In the Reading Pane, click Edit, and then scroll to the bottom of the pane.

TIP  You can edit a contact record directly in the Reading Pane or you can open it in a 
separate window by double-clicking it in the contact list.
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When editing a People card, you have fewer options than when  
editing a standard contact record.

19	 Click the plus sign to the left of Birthday, click the Birthday arrow, scroll the 
calendar to January, and then click 23 to display January 23 of the current year 
in the Birthday box.

TIP  The birthday or anniversary date you select in the calendar defaults to the 
current calendar year.
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20	 In the Birthday box, replace the current year with 1979.

21	 In the lower-right corner of the Reading Pane, click the Save button.

22	 In the contact list, click the Sarah Jones contact record. On the Home tab, in the New 
group, click the New Items button, and then click Contact from the Same Company 
to create a new contact record that already contains the company name, webpage 
address, business phone number, and business address from the Sarah Jones contact 
record. Because no person’s name has been provided, the File as name is currently 
set to the company name.

Without any changes, the new contact record could be saved as a contact record for the 
company rather than for a specific person.
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23	 In the Full Name box, enter Lola Jacobsen, and in the Job title box, enter Sales 
Associate.

24	 In the E-mail box, enter lola@wingtiptoys.com. Leave the default Display as text.

25	 Save and close the open contact record.

26	 Create a new contact record and enter the following information:

▪▪ Full name: Ben Miller

▪▪ Company: Fabrikam, Inc.

▪▪ Job title: Manufacturing Manager

▪▪ Email address: ben@fabrikam.com

▪▪ Webpage address: www.fabrikam.com

27	 After you enter the contact information, click the Save & New arrow (not the button) 
in the Actions group on the Home tab, and then click Contact from the Same 
Company to create a new contact record for Fabrikam, Inc. 

28	 Populate this contact record and create one more, to create contact records for the 
following people:

Full name Company Job title Email address
Dean Halstead Fabrikam, Inc. Quality Control 

Manager
dean@fabrikam.com

Jill Frank Fabrikam, Inc. Sales Associate jill@fabrikam.com

29	 Save and close the open contact records. The contact list now includes the five 
records you’ve created. Notice that the contact records appear in File as (last, first) 
order rather than in order by first name, even though the first name appears first in 
the contact list.

mailto:ben@fabrikam.com
mailto:dean@fabrikam.com
mailto:jill@fabrikam.com
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If an address book contains a lot of records, you can quickly scroll to those  
filed by a specific letter by clicking that letter in the contact index.

+ 	CLEAN UP  Save and close any open contact records to return to the contact list. 
Retain the Jill Frank, Dean Halstead, Lola Jacobsen, Sarah Jones, and Ben Miller contact 
records for use in later exercises.
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Communicating with contacts
Saving contact information for people in a physical or an electronic address book is useful 
because it centralizes the information in one place so that you no longer have to remember 
the information or where to find it. The added benefit of saving contact information in an 
Outlook address book is that it makes the process of initiating communication with a con-
tact much more efficient.

Initiating communication from contact records
Contact records are useful not only for storing information; you can also initiate a number 
of actions that are specific to a selected contact. Commands for initiating communication 
are available in the Communicate group on the Contact tab of an open contact record or in 
the header of a People card.

The commands available in the Communicate group may  
vary based on your specific Outlook configuration.

You can perform many actions from within a contact record window (but not in a People 
card) by using the commands in the Communicate group on the Contact tab, including the 
following:

▪▪ Create an email message addressed to the contact by clicking the Email button.

▪▪ Create a meeting request that includes the contact by clicking the Meeting button.

▪▪ Initiate a chat session with the contact by clicking the Reply With IM button (if it is 
available in your organization’s environment).

▪▪ Place a call to the contact by clicking the Call arrow and then, in the list, clicking the 
phone number you would like Outlook to dial (requires unified communications).

▪▪ Display the contact’s website by clicking the Web Page button.
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▪▪ Create a task assigned to the contact by clicking the Assign Task button.

▪▪ Display a map of the contact’s address by clicking the Map It button.

If Microsoft OneNote 2013 is installed on your computer, you can create a OneNote 
notebook entry that is linked to the contact record by clicking the OneNote button in 
the Actions group on the Contact tab.

Conforming to address standards
When you enter information in a contact record, Outlook verifies that the information 
conforms to expected patterns. If Outlook detects possible irregularities, a related dia-
log box opens, prompting you to enter information into a standard template. 

The Check Full Name and Check Address dialog boxes fit contact information into standard patterns.

The intention of these dialog boxes is to verify that you have usable contact informa-
tion available. If you determine that the information in the dialog box is correct as-is, 
you can click Cancel to close the dialog box without making changes.

TIP  You can create a contact record for the sender of a message you have received by 
right-clicking the sender’s name in the message header—either in the Reading Pane or the 
open message item—and then clicking Add To Outlook Contacts. Outlook creates a contact 
record with the name and email address already filled in. Add any other information you 
want to record, and then save the contact record.
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Selecting message recipients from address books
When you send an email message to a person whose contact information is stored in one 
of your address books, you can quickly address the message to that person by entering his 
or her name exactly as it appears in the address book and letting Outlook validate the ad-
dress. If you don’t know the exact spelling of the name, follow these steps:

1	 In the message composition window, click the Address Book button in the Names 
group on the Message tab to open the Select Name dialog box.

2	 In the Address Book list, click the arrow, and then click the address book you want to 
search.

To insert names from an address book, you must open the address book from the message 
composition window.
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3	 Scroll through the Name list, and locate the person’s name. If you have multiple email 
addresses saved for that person, the name will appear once for each email address.
TIP  You can enter the first few letters of the person’s name to scroll to entries 
beginning with those letters.

4	 To add the person in the To box as a primary message recipient, double-click the 
name, or click it and then press Enter. To add the person as a secondary or private 
recipient, click in the Cc or Bcc box at the bottom of the dialog box and then double-
click the name, or click it and press Enter.
TIP  If you click the To, Cc, or Bcc box in the message header before clicking the 
Address Book button, double-clicking the name adds the person to that box. You 
can also click the Cc or Bcc box and then click the adjacent button to open the 
Select Names dialog box with that box active.

5	 After selecting all message recipients from the address book, click OK to close the 
Select Names dialog box and return to the message composition window.

SEE ALSO  For information about creating email messages, see “Creating and sending  
messages” in Chapter 3, “Send and receive email messages.”

Displaying different views of contact records
You can view all your address books in the People module. You can also display a list of the 
contacts in an address book, including those in your organization’s Global Address List, in 
one of these ways:

▪▪ Click the Address Book button in the Find group on the Home tab of the program 
window in any module to open the Address Book window.

▪▪ Click the Address Book button in the Names group on the Contact tab of a contact 
record window to open the Select Name dialog box.

Expand the Address Book list, and then click the name of the address book whose contents 
you want to display.
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In the People module, you can view an address book in many different formats. You can 
choose any standard view from the Current View gallery on the Home tab.

The standard view options for the People module.

Each view presents information from your contact records either as cards or in a list:

▪▪ People  Displays only contact names in the contact list, and the available information 
for the selected contact in the Reading Pane. Contact names are displayed in alpha-
betical order by first or last name, depending on the File As selection. This view dis-
plays information about the contact from multiple sources. For example, if you have 
an Outlook contact record for a person you network with on LinkedIn and Facebook, 
the People card displays a compilation of the information from all three locations. 
This view, which is new in Outlook 2013, is the default view. 

▪▪ Business Card  Displays the business card associated with each contact record—either 
the default card created by Outlook or a custom card if you have one. Business cards 
are displayed in the alphabetical order specified by the File As selection.

▪▪ Card  Displays contact information as truncated business cards that include limited 
information, such as job title and company name.

▪▪ Phone  Displays a columnar list that includes each contact’s name, company, and 
contact numbers. You can choose the grouping you want from the Arrangements  
gallery on the View tab.

Buttons in the gallery on the Arrangements menu of the People module  
are available only while contact records are displayed in a list view.
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▪▪ List  Displays a columnar list with contact records arranged in groups. You can choose 
the grouping you want from the Arrangements gallery on the View tab.

In any list view, you can expand and collapse the groups or select and take action on 
an entire group of contacts. You can also enter information directly into any contact 
record field displayed in the list.

You can search and filter your contact records in any view by using the Instant Search fea-
ture from the search box at the top of the content area. You can sort contact records by any 
displayed column in a list view by clicking the column header.

KEYBOARD SHORTCUT  Press Ctrl+E to move to the search box in the active module. 
For more information about keyboard shortcuts, see “Keyboard shortcuts” at the end 
of this book.

You can change the fields displayed in each view; the way records are grouped, sorted, and 
filtered; the display font; the size of business cards; and other settings to suit your prefer-
ences. You can personalize a view from the Advanced View Settings dialog box, which you 
open by clicking View Settings in the Current View group on the View tab.

The options available in the Advanced View Settings dialog box vary  
depending on the currently displayed view.

TIP  From the Advanced View Settings dialog box, you can undo your changes to the cur-
rently displayed view by clicking the Reset Current View button, which is available only 
when the default settings for the view have been changed.
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In this exercise, you’ll look at different views of contact records within the contact list, add 
and remove columns in a list view, and reset a customized view.

	SET UP  This exercise uses the contact records you created in the exercise “Saving and 
updating contact information,” earlier in this chapter. If you didn’t complete that exer-
cise, you can do so at this time or use contact records of your own. Display the People 
module, and then follow the steps.

1	 On the Home tab, in the Current View gallery, click the Business Card button to 
display standard business cards for each contact (in addition to any personalized 
business cards you may have created). The cards are organized by File as name.

2	 On the contact index located to the right of the contact list, click the letter m to scroll 
the contact list to the business card for Ben Miller (or the first contact record in your 
People module that is filed under m).

When you have many contact records, you can scroll them by using the contact index.
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3	 In the Current View gallery, click the Card button.

4	 If the card columns are not wide enough to display the information saved with the 
contact records, click the Zoom In button at the right end of the status bar until the 
information is visible. Notice that Outlook displays the contact records in a compact 
card-like format that includes only text and no additional graphic elements.

Card view displays all the available primary contact information.

5	 In the Current View gallery, click the Phone button to display your contact records in 
a grid of columns and rows organized in ascending order based on the File as column.

6	 Click the Full Name column heading to sort the contact records in ascending order 
based on the Full Name field, as indicated by the upward-pointing sort arrow to the 
right of the column heading. You can reverse the sort order by clicking the active 
heading again.

Click any column header to sort by that column or to reverse the sort order.
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TIP  You can add a contact to your address book in any list view by clicking the box 
under the Full Name header (labeled Click Here To Add A New Contact) and entering 
the contact’s information. 

7	 Click the Company column heading to sort the contact records in ascending order 
based on the Company field.

8	 Right-click the Company column header, and then click Field Chooser to open the 
Field Chooser window.

9	 Scroll down the field list until the Job Title field is visible. Drag the Job Title field 
from the Field Chooser window to the column heading area, and when the red 
arrows indicate that it will be inserted between the Company and File as fields, 
release the mouse button. Notice that the list view now includes a column that 
displays the Job Title for each contact.

You can add any field to a list view from the Field Chooser.
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10	 Point to the column separator between Job Title and File as. When the cursor 
changes to a double-headed arrow, double-click to change the column width to 
accommodate its contents.

11	 Drag the Country/Region column header down from the column heading row until 
a black X appears. Then release the mouse button to remove the Country/Region 
column from the list view.

You can remove a column from a list view by dragging its column header away from the  
column header row.

12	 On the View tab, in the Current View group, click the Reset View button. Then in 
the Microsoft Outlook dialog box that asks whether you want to reset the view to 
its original settings, click Yes to return the Phone view to its original settings.

13	 Close the Field Chooser window. Then in the Current View gallery, click the List 
button to display the final standard view of your contact records. Notice that the 
contact records are currently grouped by company.

List view displays contact records grouped by whatever field you choose.

+ 	CLEAN UP  Return the People module to the default People view. Retain the Jill Frank, 
Dean Halstead, Lola Jacobsen, Sarah Jones, and Ben Miller contact records for use in later 
exercises.
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User-defined fields
If you’d like to save information that doesn’t fit into the default contact record fields, 
you can create a custom field. A custom field can contain information such as text, 
numbers, percentages, currency, Yes/No answers, dates, times, durations, keywords, 
and formulas.

You can create a custom information field from any view of the All Fields page of the 
contact record window by clicking the New button in the lower-left corner of the 
page and then specifying the name, type, and format of the field in the New Column 
dialog box that opens.

Custom fields can be formatted to contain  
many specific types of information.

Custom fields appear when you filter the All Fields page on User-Defined Fields In 
Folder. When you enter information in the custom field for a specific contact, it also 
appears in the User-Defined Fields In This Item list within that contact record.



	 Printing contact records      157

4

Printing contact records
You can print an address book or individual contact records, either on paper or to an elec-
tronic file (such as a PDF file or an XPS file), from any address book view. Depending on the 
view, Outlook offers a variety of print styles, such as those described in the following table.

Style Description Available in 
these views

Card Contact information displayed alphabetically in two columns. Letter 
graphics appear at the top of each page and the beginning of each 
letter group.

Business Card, 
Card, People

Small 
Booklet

Contact information displayed alphabetically in one column. 
Formatted to print eight numbered pages per sheet. Letter graphics 
appear at the top of each page and the beginning of each letter 
group, and a contact index at the side of each page indicates the 
position of that page’s entries in the alphabet.

Business Card, 
Card, People

Medium 
Booklet

Contact information displayed alphabetically in one column. 
Formatted to print four numbered pages per sheet. Letter graphics 
appear at the top of each page and the beginning of each letter 
group, and a contact index at the side of each page indicates the 
position of that page’s entries in the alphabet. 

Business Card, 
Card, People

Memo Contact information displayed under a memo-like header that 
contains your name. One record per sheet.

Business Card, 
Card, People

Phone 
Directory

Contact names and phone numbers displayed in two columns. Letter 
graphics appear at the top of each page and the beginning of each 
letter group.

Business Card, 
Card, People

Table Contact information displayed in a table that matches the on-screen 
layout.

Phone, List

You can customize the layout of most of the default print styles, in addition to saving 
custom print styles.
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In this exercise, you’ll set up Outlook to print a phone list and then to print individual 
address cards.

	SET UP  This exercise uses the contact records you created in the exercise “Saving and 
updating contact information,” earlier in this chapter. If you didn’t complete that exer-
cise, you can do so at this time or use contact records of your own. Display the People 
module in Card view, and then follow the steps.

IMPORTANT  To fully complete this exercise, you must have a printer installed. If you don’t 
have a printer installed, you can perform all the steps of the exercise other than printing.

1	 Display the Print page of the Backstage view.

In Card view, many print styles are available in the Settings list.

TIP  The Backstage view on your computer reflects your individual printer settings 
and might display other print options than those shown here.
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The preview pane displays the way the cards will appear if printed in the default Card 
Style, with the current settings. The page indicators at the bottom of the preview 
pane indicate that the cards will be printed on two pages.

2	 In the lower-right corner of the preview pane, click the Multiple Pages button to 
display both pages in the preview pane. The second page contains a series of lines 
and illegible text.

The second page of the Card Style printout provides space for you to enter  
additional contact information.

3	 In the lower-right corner of the preview pane, click the Actual Size button to display 
a full-size version of the document in the preview pane. The magnified text is large 
enough to read.

4	 At the bottom of the preview pane, to the right of the number of pages, click the 
right arrow to display the second page, which provides an area for you to record 
information about an additional contact, in the preview pane. Outlook refers to this 
page of the print style as a blank page.
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5	 In the middle pane, click Print Options to open the Print dialog box and display the 
options for the Card Style print style.

When printing contact records in the Card Style print style, you can select  
specific contact records (items) to be printed.

6	 With Card Style selected in the Print style box, click Page Setup to display the 
Format page of the Page Setup: Card Style dialog box.
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The Page Setup dialog box contents vary depending on the selected print style.

7	 Review the settings available on each of the dialog box pages. For all print styles, you 
can change the fonts, paper size, page orientation and margins, header and footer, 
and other basic settings. For this print style, you can also change the layout of cards 
on the page, the number of blank forms to be printed, and how the alphabetical 
division of the cards is indicated.

8	 In the Options area of the Format page, click None in the Blank forms at end list. 
Select the Contact index on side check box, and then clear the Headings for each 
letter check box.

9	 Click OK in the Page Setup dialog box, and then click Preview in the Print dialog box 
to display in the preview pane the previously selected Actual Size view of the card 
list. Note that it’s now only one page.
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10	 In the lower-right corner of the preview pane, click the One Page button to display in 
the preview pane the entire card list as it will appear when printed.

Alphabetical headings no longer precede the contact record cards.

11	 If you want to print the card list, click the Print button. After printing the card list, 
Outlook returns to the People module.

12	 On the Home tab, in the Current View gallery, click the List button.

13	 In the contact list, click the Lola Jacobsen contact record to select it, press and hold 
the Ctrl key, and then click the Sarah Jones contact record to add it to the selection.
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14	 Display the Print page of the Backstage view. Notice that the Settings list displays 
only two options—Table Style and Memo Style. Memo Style is selected by default.

15	 If a Preview button appears in the preview pane, click it to preview the selected 
contact records.

By default, Memo Style prints one contact record per page.

16	 In the Settings list, click Table Style. The preview of Table Style indicates that all 
contact records will be printed rather than only the two you selected.

17	 In the middle pane, click Print Options to open the Print dialog box and display the 
options for the Table Style.
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When printing contact records in Table Style, you can select specific items to be printed.

18	 In the Print range area, click Only selected rows. Then click Preview to reflect your 
change.

19	 If you want to print the selected records, click the Print button.

20	 Experiment with the other ways in which you can print your contact records and your 
address book.

+ 	CLEAN UP  Return to the default People view or your preferred view of the People 
module before continuing to the next chapter. Retain the Jill Frank, Dean Halstead, 
Lola Jacobsen, Sarah Jones, and Ben Miller contact records for use in exercises in later 
chapters.
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Key points
▪▪ You can create and access different types of address books, including the Global 

Address List provided by your Exchange Server account, your main address book, 
and any custom address books that you create.

▪▪ Contact records can include names, email and IM addresses, phone numbers, mailing 
addresses, birthdays, and other information.

▪▪ You can display contact records in many different views. In card views, you can move 
among records by clicking the contact index. In list views, you can sort records by any 
field.

▪▪ You can print your address book or individual contact records in several formats.
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Manage contact records

IN THIS CHAPTER, YOU WILL LEARN HOW TO

▪▪ Create address books.

▪▪ Import and export contact records.

▪▪ Create contact groups.

▪▪ Quickly locate contact information.

▪▪ Personalize electronic business cards.

If you regularly save contact information for business and personal contacts in Microsoft 
Outlook, you will quickly accumulate a large collection of contact records. Being able to or-
ganize and quickly locate specific contact information is important for efficient communica-
tions. The more people you deal with on a daily basis, the more important it is to keep your 
contact list organized. You can simplify communications with specific groups of people by 
creating contact groups to which you can address messages as you would an individual con-
tact. You can also create purpose-specific address books and organize contact records within 
the address books to make it easier to locate specific contact records. You can add contact 
records to a custom address book either by moving contact records that are already stored 
in Outlook, or by importing contact records from another program or file.

The Search feature of Outlook 2013 makes it easy to find a specific contact record based 
on any text within the contact record or any attribute, such as a color category that you 
assign to it. Within each contact record, you can make preferred contact information easily 
discoverable by displaying it on the electronic business card version of the contact record. 
You can also display images, such as photographs or corporate logos on business cards, to 
provide additional information when you view contacts in the default Business Card view.

In this chapter, you’ll first organize the contact records associated with this book into an in
dividual address book. You’ll import a fresh set of contact records into the custom address 
book, and then export a subset of the records. Then you’ll create a contact group and send 
a message to a subset of the group. You’ll locate specific contact records by using the Search 
feature and the commands available on the new Search tool tab. Finally, you’ll personalize 
the content of an electronic business card.
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PRACTICE FILES  To complete the exercises in this chapter, you need the practice files 
contained in the Chapter09 practice file folder. For more information, see “Download the 
practice files” in this book’s Introduction. The exercises in this chapter also use Outlook 
items you created in exercises in previous chapters. If an exercise requires an item that you 
don’t have, you can complete the exercise in which you create the item before beginning 
the current exercise, or you can substitute a similar item of your own.

Creating address books
Outlook displays your default address book when you click the People link or button on 
the Navigation Bar. The default address book content is stored in a folder named Contacts. 
If you connect to a Microsoft Exchange Server account, the default address book is part of 
that account, and the information you store in the address book is available on all devices 
from which you connect to your account. Exchange Server also provides a Global Address 
List (GAL), which is an address book maintained centrally by your Exchange administrator.

You can track all your contacts—business and personal—within the address book of your 
default email account. However, you might find it useful to create a separate address book 
that contains contact records for only a specific group of people. For example, you might 
want to have an address book that contains only clients, relatives, club members, neighbor-
hood contacts, parents and teachers from your child’s school, or sports teammates.

TIP  When searching for a specific contact record, you can search a single address book or 
search all address books within your Outlook configuration, including your organization’s 
GAL. For more information, see “Quickly locating contact information” later in this chapter.

You create an additional address book by creating a folder that has a designated purpose 
of containing contact items (a contact folder). You can move and copy contact records be-
tween address books in your Outlook configuration. As with other folders, you can share 
the contact folder with other Outlook users on your network, or you can export it for dis-
tribution to other people. Unlike the Calendar module, in which you can display multiple 
calendars, the People module can display only one address book at a time. When you 
have multiple address books, you can switch among them by choosing the address book 
you want to display from the list in the Folder Pane of the People module or from the 
Folder List in the Mail module.

TIP  You can’t display your organization’s GAL from the Folder Pane. To display it, click the 
Address Book button in the Find group on the Home tab of the People module.
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In this exercise, you’ll create an address book and move existing contact records into it. 

	SET UP  You need the contact records you created in Chapter 4 to complete this exer-
cise. If you didn’t create those contact records, you may do so now or substitute any con-
tact records of your own. Display the People module, and then follow the steps.

1	 On the Folder tab, in the New group, click the New Folder button to open the 
Create New Folder dialog box.

Because you are creating this folder from within the People module, Contact Items is selected 
by default. However, you can create any type of folder from within any module.

2	 In the Name box, enter SBS Contacts.

TIP  The name of this folder begins with SBS so that you can easily differentiate it 
from other folders in your mailbox. 

3	 In the Select where to place the folder list, click your account name (or Mailbox, 
depending on your account configuration) to place the new folder at the same level 
in the Folder List structure as your default module folders.
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You can create a contact folder anywhere within the existing folder structure.

4	 In the Create New Folder dialog box, click OK to create the SBS Contacts address 
book. The address book appears in the My Contacts list.

The Folder Pane of the People module lists all the available contact folders.

5	 On the Navigation Bar, click the Mail button to display your Inbox. Notice that the 
SBS Contacts folder is not visible in the Folder Pane.

6	 Click the Folders button to display the Folder List, which includes all the folders 
in your Outlook configuration rather than only those containing mail items. The 
SBS Contacts folder appears in alphabetic order in the list.

A contact card icon next to the folder name indicates  
that it is a contact folder, designed to hold contact items.
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7	 In the Folder Pane, click the SBS Contacts folder to display the currently empty 
address book. Although the Folder List still appears in the Folder Pane, the ribbon 
displays the groups appropriate to an address book.

8	 On the Navigation Bar, click the People button to display the usual People module 
Folder Pane, which provides easy access to your address books.

The same features available within your main address book, such as  
the contact index, are available within this custom address book.

9	 In the My Contacts list, click Contacts to display your default address book, which 
currently contains the five contact records you created in Chapter 4.

10	 In the contact list, click the Jill Frank contact record once to select it.

11	 Drag the selected contact record from the contact list to the SBS Contacts address 
book in the Folder Pane. The record disappears from the contact list. 

TIP  To copy rather than move a contact record, right-click and drag the contact 
record to the destination address book and then, when you release the mouse 
button, click Copy on the shortcut menu.

12	 In the contact list, if the Dean Halstead contact record is not already selected, click it 
once to select it.

13	 On the Home tab, in the Actions group, display the Move list.
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The Move list includes your custom and standard folders; you can browse to other folders.

14	 In the Move list, click SBS Contacts to move the selected contact record.

TIP  If the SBS Contacts folder doesn’t appear in your Move list, click Other Folder and 
then select SBS Contacts in the Move Items dialog box.

15	 In the contact list, click the Lola Jacobsen contact record. Press and hold the Ctrl key, 
and then click the Sarah Jones and Ben Miller contact records in turn to select all the 
contact records you’ve created for this book that remain in your main address book.

16	 Right-click any one of the selected contact records, click Move, and then click SBS 
Contacts to move the contact records.

17	 In the Folder Pane, click SBS Contacts to display the custom address book, which 
now contains the five records you moved there.

The contact records you’ve created for this book are now collected in the custom address book.

+ 	CLEAN UP  Retain the SBS Contacts folder and its contents for use in later exercises.
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Importing and exporting contact records
In addition to copying and moving contact records between address books within your 
Outlook configuration, you can import contact records into an existing address book from 
external files and programs. Outlook accepts data imported from non–application specific 
files, files created in other Microsoft programs, and files created in third-party programs.

You can import data into Outlook from data files created in Outlook (.pst files) or from 
plain-text files that contain field values separated by commas (.csv files). Similarly, you can 
export contact records from Outlook for import into Outlook or another program.

TIP  In previous versions of Outlook, you could directly import content from many other 
sources. To import content stored in another source program, export it from that program 
to a .csv file and then import the .csv file. To import a file that contains contact records into 
a separate address book, first create the address book, and then import the file.

In this exercise, you’ll import contact records from a tab-separated (also referred to as tab-
delimited) text file into an existing address book. Then you’ll export a selection of records 
from the updated address book to a file that other Outlook users can import, and you’ll test 
that you successfully exported only the records you wanted.

	SET UP  You need the SBS Contacts address book you created in the previous exercise, 
and the SBSContacts file located in the Chapter09 practice file folder to complete this 
exercise. If you didn’t create the address book, you may do so now or substitute any 
existing address book. Display the SBS Contacts address book, and then follow the steps.

1	 Display the Open & Export page of the Backstage view.

Opening a file creates a link to the external file; importing adds the data to your Outlook folders.
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2	 On the Open & Export page, click Import/Export to start the Import and Export 
wizard.

You can export and import specific items or entire RSS feeds.

3	 With Import from another program or file selected in the Choose an action to 
perform list, click Next to display the list of file types from which you can import 
content.

Outlook 2013 accepts data only from .csv and .pst files.
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TIP  Although the name shown in the title bar of the wizard changes to Import A File, 
this page is still part of the Import And Export wizard.

4	 In the Select file type to import from list, click Comma Separated Values. Then 
click Next.

You can choose whether to allow, refuse, or replace duplicate files.

5	 Click the Browse button to the right of the File to import box to open the Browse 
dialog box. In the Browse dialog box, navigate to the Chapter09 practice file folder, 
click the SBSContacts file, and then click OK.

6	 In the Options area, click Replace duplicates with items imported. Then click Next. 
Because you started the wizard from the SBS Contacts address book, that folder is 
already selected as the destination folder.
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You can import content into any type of folder.

7	 With SBS Contacts selected in the Select destination folder list, click Next. The 
wizard displays a description of the import operation and provides additional 
configuration options.

You can choose to map custom fields or change the destination of the imported content.

8	 On the wizard’s last page, click Map Custom Fields to open the Map Custom Fields 
dialog box. In this dialog box, you can match named fields from the import source 
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file to named fields in Outlook. You might need this functionality when you import 
content from a file that was not originally created in Outlook.

If the structure of the imported records is different from the Outlook contact record structure, 
you can match incoming data fields to Outlook data fields before you import the content. 

9	 Scroll down the From list and note the fields that are present in the source file. Then 
in the area below the From list, click Next to display in the Map Custom Fields dialog 
box the first record in the source file.

10	 In the To list, click the Expand button to the left of Name to display all the name 
fields. The Mapped From column displays the value from the current source record 
that maps to each of the Outlook fields.

TIP  While testing this functionality, Outlook sometimes displayed the mapping 
results incorrectly, although the import process worked correctly. We hope that 
this issue will be resolved in a future software update.

11	 Click Next a few times to view additional records, and scroll the To list to review the 
way the records map to the Outlook fields. Then click OK to close the Map Custom 
Fields dialog box.
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12	 On the last page of the Import and Export wizard, click Finish to import the contact 
records into the SBS Contacts address book. In a few seconds, the address book 
contains 11 contact records.

13	 On the Home tab, in the Current View gallery, click Card to display information from 
multiple records. Notice that the five contact records you created earlier in this book 
now contain additional information. In fact, new versions of these contact records 
were imported from the SBSContacts file. Because in step 6 you selected the option 
to replace duplicate records, the new records, which contain additional information, 
replaced the records you created. 

Imported and replaced contact records.

Now you’ll export selected records from the updated address book for distribution to 
other Outlook users.

14	 On the Open & Export page of the Backstage view, click Import/Export to start the 
Import and Export wizard.

15	 In the Choose an action to perform list, click Export to a file, and then click Next. 
As with the import process, in Outlook 2013, you can export only to a .csv or .pst file.

16	 In the Create a file of type list, click Outlook Data File (.pst). Then click Next.

Now we’ll select the records to export.
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The SBS Contacts folder is selected for export.

17	 With SBS Contacts selected in the Select the folder to export from list, click Filter 
to open the Filter dialog box. From this dialog box, you can filter the contents of the 
selected folder so that only items (in this case, contact records) that meet specific 
criteria are exported.

18	 On the Contacts page of the Filter dialog box, enter Northwind in the Search for 
the word(s) box. Then click the In arrow to display the types of fields on which you 
can filter contact records.

Contact record filtering options.



322      Chapter 9  Manage contact records 

19	 In the In list, click company field only. Then in the Filter dialog box, click OK.

20	 In the Export Outlook Data File wizard, click Next.

The default settings for the export process save the exported file as backup.pst in a 
subfolder of your user profile named Outlook Files. Instead, we will save the file in the 
practice file folder.

21	 To the right of the Save exported file as box, click the Browse button. In the Open 
Outlook Data Files dialog box, navigate to the Chapter09 practice file folder. In the 
File name box, enter NorthwindContacts. Then click OK.

You can export items to a new or existing .pst file.

22	 On the wizard’s last page, click Finish. Before exporting the records, Outlook gives 
you the options to password-protect the file.

You can keep the contents of an Outlook data file  
confidential by assigning a password to the file.
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23	 In the Create Outlook Data File dialog box, click OK to create the file without 
assigning a password.

24	 To test that you successfully exported the file, use the techniques you learned in this 
chapter to create a contact folder named SBS Northwind, as a subfolder of the SBS 
Contacts address book and import the NorthwindContacts data file into it. During 
the import process, the Import Outlook Data File wizard prompts you to select the 
folder you want to import and the import location.

Contact record importing options.

25	 In the Select the folder to import from list, click SBS Contacts (the folder from which 
you exported the data file). Click the Import items into the current folder option. 
Then click Finish to import the records from the NorthwindContacts data file into 
the SBS Northwind address book.

26	 After you import the contact records, notice that the People cards for each contact 
display information from multiple sources.
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The People cards for Northwind Traders employees display information from both address 
books.

TIP  Sources can include Outlook address books and external networks that you 
connect to, such as LinkedIn and Facebook. Contact records that contain matching 
information will link automatically; you can manually link or unlink contact records 
by clicking Link Contacts.

Now we’ll delete the new address book to avoid confusion in later exercises.

27	 In the Folder Pane, right-click the SBS Northwind address book, click Delete Folder, 
and then click Yes in the Microsoft Outlook dialog box that appears.

+ 	CLEAN UP  Retain the SBS Contacts address book and its contents for use in later 
exercises.

TIP  In the preceding exercise, we imported and exported contact records, but you can use 
the same process to import and export other Outlook items.
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Creating contact groups
If you frequently send messages to specific groups of people, such as members of a project 
team, club, or family, you can create a contact group that contains all the email addresses. 
Then you can send a message to all the group members by addressing it to the contact 
group.

Contact groups are like personal versions of distribution lists. A distribution list is available 
to everyone on your Exchange Server network; a contact group is available only from the 
local address book you store it in. You can, however, distribute a contact group to other 
people for their own use.

The ribbon provides a separate tab of commands for managing contact groups.

You add a member to a contact group either by selecting an existing contact record from 
an address book or by entering contact information in the Add New Member dialog box. 
When you add a member by using the latter method, you have the option to simultane-
ously create a contact record for him or her.

When you send a message to a contact group, each member of the contact group receives 
a copy of the message. If you want to send a message to most, but not all, members of 
a contact group, you can expand the contact group in the address field to a full list of its 
members, and remove individual people for the specific message at the time you send it.



326      Chapter 9  Manage contact records 

In this exercise, you’ll create a contact group and add new contacts to your address book. 
Then you’ll send a message to all but one member of the contact group.

	SET UP  You need the contact records you imported into the SBS Contacts address 
book in the previous exercise. If you didn’t import the contact records, you may do so 
now or substitute contact records of your own. Display the SBS Contacts address book  
in List view, and then follow the steps.

1	 On the Home tab, in the New group, click the New Contact Group button to open 
the Contact Group window.

2	 In the Name box, enter SBS Project Team. Then on the Contact Group tab, in the 
Members group, click the Add Members button to display the locations from which 
you can add contacts to the contact group.

You can add members to a group from existing records or by entering email addresses.

3	 In the Add Members list, click From Outlook Contacts to open the Select Members 
dialog box, which displays the contents of your default Contacts address book.

4	 In the Address Book list, click SBS Contacts to display the contents of the SBS 
Contacts address book that you created and populated in previous exercises in 
this chapter.
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You can search for contacts in the Select Members dialog box by name or by other criteria.

5	 In the Name list, click Steve Masters, and then in the lower-left corner of the dialog 
box, click the Members button to display Steve Masters (work) in the Members box. 
This is the display name stored in Steve’s contact record.

6	 In the Name list, double-click the first Sarah Jones entry to add Sarah Jones (work) 
to the Members box.

TIP  You can add individual people, resources, distribution lists, public folders, mail-
enabled Microsoft SharePoint site libraries, and other contact groups to a contact 
group. You can quickly add multiple entries to the Members box by double-clicking 
each name, or by holding down the Ctrl key while selecting multiple names, and then 
clicking the Members button.
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7	 In the Select Members: SBS Contacts dialog box, click OK to add the two contacts 
to the SBS Project Team contact group.

Contact group members added from an address book are listed by the Display As names 
saved in their contact records.

8	 In the Add Members list, click New E-mail Contact to open the Add New Member 
dialog box.

9	 In the Add New Member dialog box, enter Delphine Ribaute in the Display name 
box and delphine@wideworldimporters.com in the E-mail address box.

When the Add To Contacts check box is selected, the new contact  
group member will also be added to your default address book.
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10	 In the Add New Member dialog box, click OK to add Delphine to the SBS Project 
Team contact group and to your default address book.

TIP  We usually keep the contacts you create while working through the exercises in 
this book separate from your own contacts. For the purpose of the “Quickly locating 
contact information” exercise later in this chapter, we will create three contact records 
in your Contacts address book and clean them up in the later exercise.

11	 Repeat steps 8 through 10 to add the following people to the contact group and to 
your Contacts address book:

Display name Email address
Sara Davis sara@wideworldimporters.com
Max Stevens max@wideworldimporters.com

Each new contact group member appears in the contact group in alphabetical order.

The folder in which the contact group is being created is shown in the lower-left corner  
of the dialog box.

12	 On the Contact Group tab, in the Actions group, click the Save & Close button to 
create the contact group in the SBS Contacts address book.
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Contact group names are displayed in bold font so that you can easily differentiate them from 
individual contact records.

TIP  The three contact group members you added manually do not appear in this 
address book; Outlook created their contact records in your default Contacts address 
book.

13	 In the contact list, click the SBS Project Team contact group. Then on the Home tab, 
in the Communicate group, click the Email button to open a message composition 
window. The message is addressed to the SBS Project Team contact group.

14	 In the To box, click the Expand button to the left of SBS Project Team. Outlook 
displays a warning that you can’t collapse the contact group after you expand it.
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In a message header, the contact group name is bold and is preceded by an Expand button.

15	 In the Expand List message box, click OK to replace the contact group name with 
the individual names or display names of its members. You can remove any group 
member from the address box before sending the message.

When you expand the contact group, the names of the group members replace the contact 
group name.

TIP  If your organization uses a version of Exchange Server that supports MailTips, the 
individual message recipient names change to a green font, and a MailTip appears 
above the To box in the message header, notifying you that the message is addressed 
to recipients outside of your organization. MailTips are a feature of Exchange Server 
that displays information in email messages based on centrally stored information 
about the organization and its individual members.

16	 Close the message window without saving or sending the message. (The message 
recipient addresses are fictitious.)

+ 	CLEAN UP  Retain the SBS Project Team contact group and the Delphine Ribaute, Max 
Stevens, and Sara Davis contact records for use in later exercises.
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Quickly locating contact information
You can use the Search feature in any Outlook module to immediately find a specific 
Outlook item within the current folder, an item of the same type in any folder, or an item 
of any type in any folder. Finding an item that contains, for example, a specific word is as 
simple as entering that word in the Search box at the top of the content area. When you 
position the cursor in the Search box, the Search tool tab appears on the ribbon. You can 
refine your search criteria or expand your search to include additional locations by using 
the commands available on the Search tab.

In this exercise, you’ll locate specific contact records, and work with the contact records 
from the search results.

	SET UP  You need the contact records you imported into the SBS Contacts address 
book earlier in this chapter, and the Delphine Ribaute, Max Stevens, and Sara Davis 
contact records you created in the previous exercise. If you didn’t create those contact 
records, you may do so now or substitute contact records of your own. Display the SBS 
Contacts address book in Card view, and then follow the steps.

1	 At the top of the contact list, click to position the cursor in the Search box, and 
activate the Search tool tab on the ribbon.

KEYBOARD SHORTCUT  Press Ctrl+E to position the cursor in the Search box of the 
current module.

Filters on the People module Search tool tab are specific to information stored in contact records.

2	 In the Search box, enter sa. Notice that as you enter the letters, Outlook filters the 
list to display only those contact records that contain the letters you’ve entered, and 
highlights the matches in the contact records. This highlighting appears in any view 
other than Business Card view.
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TROUBLESHOOTING  If Outlook doesn’t automatically filter the contact records, press 
Enter or click the Search button after you enter the search term.

Outlook locates the letters at the beginning of any word.

3	 In the Search box, replace sa with steve. As you type, Outlook filters the records in 
the SBS Contacts address book to locate Steve Masters.

Let’s focus our search on Mr. Stevens, who is a member of the SBS Project Team 
contact group.

4	 On the Search tool tab, in the Scope group, click the All Contact Items button. The 
search results expand to display contact information for Steve Masters and Max 
Stevens, in addition to any other contacts that meet the criteria. Because we’re no 
longer working specifically in the SBS Contacts address book, the view changes to 
the default People view.

5	 In the contact list, click Max Stevens to preview his information.

Next let’s locate a co-worker of Mr. Stevens.

TIP  You can quickly repeat previous searches by clicking in the Search box to display 
the Search tool tab, clicking the Recent Searches button in the Options group of the 
Search tab, and then clicking the criteria of the previous search you want to repeat.
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A refined search.

6	 In the Search box at the top of the contact list, click the Close Search button (the X) 
to return to the SBS Contacts address book.

TIP  You can also cancel the current search by clicking the Close Search button on 
the Search tool tab.

7	 Click in the Search box, and then on the Search tool tab, in the Refine group, 
click the More button. In the list, click Company to display a Company box in 
the Search pane.

8	 In the Company box, enter Wide World Importers. As you enter the company 
name, Outlook populates the Search box with the correct criteria for the search.

When a single search criterion includes multiple words, Outlook encloses the  
words in parentheses.

The search returns no results because no contact records containing that phrase exist 
in this address book. You added the contacts from Wide World Importers to the ad-
dress book when you created the SBS Project Team contact group, and the contact 
group entries included only the first name, last name, and email address for each 
person.

9	 Click the Remove button to the right of the Company box to remove the 
corresponding criterion from the Search box.
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10	 In the Refine group, click the More button and then, in the list, click E-mail to display 
an E-mail box in the Search pane.

11	 In the E-mail box, enter wideworldimporters to enter the corresponding search 
criterion in the Search box. Your search still yields no matching contact records 
because Outlook creates contact records in your default address book when adding 
people by email address to a contact group; you are currently searching the SBS 
Contacts address book.

12	 On the Search tab, in the Scope group, click the All Contact Items button to locate 
the three contact records you created in the previous exercise. In the Reading Pane, 
the source is specified as your Contacts address book.

Email address is one of the criteria by which you can conduct a search.

13	 In the contact list, click any one of the three contact records, and then press Ctrl+A 
to select all three. Drag the selected contact records from the contact list to the SBS 
Contacts address book in the Folder Pane.

14	 In the Folder Pane, click the Contacts address book and verify that the three contact 
records are no longer there.

15	 Click the SBS Contacts address book. On the Home tab, in the Current View gallery, 
click the List thumbnail. Confirm that the contact records for Sara Davis, Delphine 
Ribaute, and Max Stevens are now stored in this address book with the other contact 
records and the contact group that you have created while working through this book.
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The final contents of the SBS Contacts address book.

+ 	CLEAN UP  Click in the Search box to activate the Search pane, and then click the 
Remove button to the right of the Email box to remove this field from the pane.

Sending business cards
You can send entire contact records to other Outlook users to add to their address 
books or, if you prefer to share only the information shown on the associated business 
card, you can send the business card. To send an Outlook business card:

1	 In any view of the address book, click the contact record whose business card you 
want to send.

2	 On the Home tab, in the Share group, click the Forward Contact button, and then 
click As a Business Card to create a new message that has the business card at-
tached as a file and displayed in the content area. The contact name is displayed 
in the Subject box in the message header.

3	 Address and send the message.

TIP  You can include a business card as part or all of your email signature by clicking 
the Business Card button while creating or editing a signature. For information about 
email signatures, see “Personalizing the appearance of message text” in Chapter 10, 
“Enhance message content.”
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Personalizing electronic business cards
Within each contact record window, information appears not only in the fields of the con-
tact record but also in the form of a graphic that resembles a business card. When you 
enter a person’s contact information in a contact record, basic information appears in the 
business card shown in the upper-right corner of the contact window. This data includes the 
person’s name, company, and job title; work, mobile, and home phone numbers; and email, 
postal, webpage, and instant messaging addresses. (Only the first 10 lines of information 
fit on the card.) If an image is associated with the person through Exchange, SharePoint, or 
a social network to which you’ve connected Outlook, the contact record includes the im-
age. You can change the types of information that appear, rearrange the information fields, 
format the text and background, and add, change, or remove images, such as a logo or 
photograph.

Creating a business card for yourself provides you with an attractive way of presenting your 
contact information to people you correspond with in email. You can attach your business 
card to an outgoing email message or include it as part (or all) of your email signature. The 
recipient of your business card can easily create a contact record for you by saving the busi-
ness card to his or her Outlook address book.

SEE ALSO  For information about email signatures, see “Personalizing the appearance of 
message text” in Chapter 10, “Enhance message content.”

In this exercise, you’ll modify the business card associated with a contact record.

	SET UP  You need the JoanLambert image located in the Chapter09 practice file folder 
and the SBS Contacts address book you created and populated in earlier exercises in this 
chapter to complete this exercise. Display the SBS Contacts address book in Business 
Card view, and then follow the steps.

1	 In the contact list, double-click the Joan Lambert contact record to open the contact 
record window. The business card in the upper-right corner displays information stored 
in the contact record fields. The grayscale graphic on the left side of the business 
card is a placeholder image.
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The default business card displays the information stored in the contact record.

2	 On the Contact tab, in the Options group, click the Picture button, and then click 
Add Picture. The Add Contact Picture dialog box opens, displaying the contents of 
your Pictures library. You can add a business logo, your photograph, or any other 
image to a business card.

3	 In the Add Contact Picture dialog box, navigate to the Chapter09 practice file folder, 
click the JoanLambert image, and then click OK to replace the image placeholder in 
the contact record window and business card with the photo of Joan. Notice that the 
space allocated to the image changes and the content moves to the right.

4	 In the Options group, click Business Card to open the Edit Business Card dialog box, 
in which you can modify the contents of the business card.
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The default placement of an image on an electronic business card is to the left of the  
contact information.

5	 In the Card Design area, in the Layout list, click Image Right to move the photo from 
the left side of the card to the right side.

6	 In the Image Area box, enter or select (by clicking the arrows) 40% to dedicate that 
horizontal portion of the card to the image.

7	 In the Image Align list, click Fit to Edge to expand the photo to the full height of the 
business card.

8	 In the Card Design area, click the Background Color button to open the Color dialog 
box. In the fifth row of the Basic colors palette, click the second swatch to select a 
brown color that coordinates with colors in the image.
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9	 In the Color dialog box, click OK to apply the new background color to the card 
preview. Notice that some of the text on the card might be difficult to read against 
the dark background.

10	 With Full Name selected in the Fields list, click the Font Color button at the top of 
the Edit area (not the button associated with the Label field). In the Color dialog box, 
in the lower-right corner of the Basic colors palette, click the white swatch. Then click 
OK. The name on the business card now stands out from the background color.

11	 In the Fields list, click Company, and then change the color of the company name 
shown on the business card from black to light yellow (the second swatch in the top 
row of the Basic colors palette).

12	 In the Fields list, click Job Title. Then below the Fields list, click Remove to remove 
the job title from the business card (but not from the contact record).

13	 In the Fields list, click the first Blank Line entry. Below the Fields list, click the Move 
Field Up button five times (pausing between clicks) to position a blank line after the 
company name.

14	 In the Fields list, click E-mail. Then click the Move Field Up button two times to 
position the email address before the phone numbers.

15	 Use the techniques you learned in this exercise to do the following:

▪▪ Remove the Business Address field from the business card.

▪▪ Insert a blank line between the Mobile Phone and Business Home Page fields.

▪▪ Change the color of the E-mail, Business Phone, and Mobile Phone information 
to light gray (the third swatch from the right in the last row) and the Business 
Home Page information to light yellow.

After completing these changes, the business card looks very different from the 
original.
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You can easily modify the layout and formatting of an electronic business card.

TIP  You can modify field labels by clicking the field and then changing the label text, 
position, and color in the Label area to the right of the Fields list.

16	 In the Edit Business Card dialog box, click OK to display the customized business 
card in the contact record window.

TIP  You can undo all the changes you’ve made to a business card by clicking the 
Reset Card button at the bottom of the Edit Business Card dialog box.
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17	 On the Contact tab, in the Actions group, click the Save & Close button to display 
the personalized business card among the default business cards in the address book.

A personalized business card stands out from other contact records.

+ 	CLEAN UP  Retain the SBS Contacts address book and its contents for use in exercises 
in later chapters.
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Key points
▪▪ To more specifically organize contact records, you can create separate address books.

▪▪ You can import information into an Outlook address book from many external sources, 
and export information to share with other people who are using other programs.

▪▪ Creating and making use of contact groups saves time if you frequently send messages 
to a specific group of people.

▪▪ The Search feature makes short work of locating a specific contact or item of infor-
mation in a contact record.

▪▪ You can customize the information shown in the electronic business card for each 
contact record, including your own.
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calendars (continued)
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business cards, personalizing, 337
changing filing order of, 136
closing and saving, 80
communication types, displaying, 79
copying, 313
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contacts (continued)
business cards, displaying, 152
calling, 146
email addresses, entering, 138
mailing addresses, setting default, 139
names, entering, 138
photographs for, 121
presence icons for, 119

Contacts address book, 136. See also address books
contents of, 310
displaying, 74

Contacts module. See People module
content area, 41

defined, 510
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content panes, defined, 510
context menus, defined, 514
contextual tabs. See tool tabs
Conversation view, 112

customizing settings, 234
enabling, 233
troubleshooting, 237
working with, 232

conversations
defined, 510
arranging, 237
cleaning up, 236, 409
deleting, 236
displaying messages from specific folders, 234
display options, 233
expanding, 233, 235, 414
finding messages in, 237
ignoring, 236
indenting, 235
managing messages as a group, 236
moving into and out of folders, 257
searching, 237
selecting all messages in, 236
senders, displaying, 235
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copying
between Office programs, 355

calendar items, 283
configuring options for, 406
contact records, 313
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SmartArt graphics, 389
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Create New Folder dialog box, 137, 255, 311, 312
Create Outlook Data File dialog box, 323
creating email messages, 51, 57, 88

addressing, 88
configuring options for, 405, 411
entering content, 93
opening message windows, 95
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cropping pictures, 373

to aspect ratios, 375
.csv files. See comma-separated values (CSV) files
current view, customizing, 48
cursor, defined, 510
custom calendars, 282
Custom dialog box, 207
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cutting and pasting, 406. See also copying

D
Daily Task List

displaying, 220
hiding, 277

data files, configuring, 17
Date Navigator, 191, 65

defined, 510
Day view, 189
declining

meeting requests, 186
task requests, 214, 215, 216

default folder, setting, 423
Delegate Permissions dialog box, 293
delegating calendar control, 292
Deleted Items folder, 46

emptying, 265, 423
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deleting
address books, 324
categories, 250
conversations, 236
flags, 213
holidays from calendar, 175
junk email, 461, 464
messages, 265, 414
Quick Step actions, 449
signatures, 355
tasks, 202, 213

delivery receipts, 
configuring, 413
requesting, 392

desktop alerts, 102, 106. See also notifications
defined, 510
configuring, 106, 404, 409
managing, 32

Detailed view, 221
displaying, 223

diagrams. See charts; SmartArt graphics
dial-up connections, discontinuation of, 8
dialog box launcher, 28

defined, 510
dictionaries, configuring, 421
digital certificates

displaying, 20, 78
error messages, 20
managing, 470
renaming, 470

digital IDs
importing and exporting, 469
obtaining, 467
S/MIME, obtaining, 469

digital signatures, 391
defined, 510
applying to messages, 470, 473
configuring, 467

disconnecting Outlook from the Internet, 49
display options, configuring, 406
display settings, changing, 31

distribution lists, 120. See also contact groups
defined, 510
adding to contact groups, 327

docking, module peeks, 44, 400
document libraries

connecting to other computers, 500
connecting to Outlook, 499
subfolders, indicators for, 501
updating subscriptions to, 500
working offline with, 499

document workspaces, 510
defined, 510

domains
defined, 510
blocking messages from, 466

download options for Cached Exchange Mode, 489
drafts, 95

defined, 510
editing, 97
saving, 95, 411

Drafts folder, 46, 94, 95, 411
drawings, inserting, 364
due dates

grouping messages by, 239
for tasks, assigning, 84, 418

E
Edit Business Card dialog box, 338
Edit Quick Step dialog box, 260, 446, 450
Edit Rule dialog box, 496
editing

business cards, 338
contact records, 141
meeting requests, 185
message drafts, 97
Quick Steps, 260, 446
rules, 453, 496
signatures, 359
tasks, 210

Editor Options dialog box, 405
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electronic business cards. See business cards
electronic notes. See notes
email, defined, 510
email accounts

adding, 12
address books for, 136
calendars, accessing, 282
configuring, 10, 17
connecting to, 10
default folders for, 46
encrypting, 22
Exchange Server, 9, 15, 18, 177
grouping messages by, 239
Internet, 21
managing multiple, 104
manually configuring, 14
multiple, adding, 10
naming, 16
problems connecting to, 14
Quick Steps for, 258
saved messages in, 95
send/receive options, enabling, 488
setting up, 8
signatures for, 355, 359
synchronizing with, 66, 177
testing settings for, 23
troubleshooting connection problems, 20

email addresses
adding to messages, 53
for contacts, entering, 138
entering in messages, 89
resolving, 89, 148, 411
separating with commas, 411

email attachments. See attachments
email conversations. See conversations;  

Conversation view
email etiquette, 125
email messages

defined, 510
applying categories to, 247
arranging, 237
assigning categories to, 250

attachments, inserting, 105
backgrounds, applying, 347
blocking external content in, 476
calendars, sending as, 294
Cc field, copying recipients with, 89
Conversation view, 232, 233
creating calendar items from, 176
creating from contact records, 80, 146
creating tasks from, 202
deleting, 265, 414
delivery options, setting, 392
digitally signing, 391, 467, 470, 473
due dates, assigning, 203
editing drafts, 97
encrypting, 391, 468, 474
entering content, 93
filtering, 242
flagging for follow-up, 202, 204, 391, 449
flags, removing, 213
fonts, changing, 356
formats supported for, 93
formatting options, 414
formatting text, 54, 59
forwarding, 124, 128, 258
grouping, 239, 240, 241
headers and footers, adding, 272
icons for, 49
importance, setting, 53, 391
inserting items into, 54
junk email settings, configuring, 465
marking as read/unread, 244
marking for follow-up, 53
moving, 256, 258, 455
notifications for, 102, 106
opening in new windows, 118
organizing with folders, 253
participant information, viewing, 119
permissions, restricting, 393
permissions, setting, 475
personalizing, 93
pictures, inserting, 369
plain text, sending/receiving, 475
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popping out into windows, 99
previewing, 108, 109, 114, 269, 402
printing, 268
Quick Steps for, 258, 446, 455
reading and opening, 109
recalling, 130
replying to, 123, 127, 258
resending, 130
restricting actions on, 475
saving, 94, 95, 410
in Search Folders, changing/deleting, 265
searching, 262, 266
selecting, 236
selecting account to send from, 104
sending, 102, 258
sensitivity, setting, 391
settings, changing, 390
sorting, 240, 241
stationery, applying, 347
status, changing, 244
styles, applying, 350
subject, including, 88
themes, applying, 347
tracking, 392
transferring to task lists, 202, 205
unread, displaying, 109, 243
viewing, 108, 112
viewing blocked content, 476
views for, 237
voting buttons, adding, 391

email servers, defined, 510
email signatures. See signatures
email trails, defined, 511
emptying Deleted Items folder, 265, 423
encoding, configuring, 426
encrypted connections

problems with, 20
setting up, 22

encrypting email messages, 391, 468, 474
encryption, defined, 511

event windows, 
defined, 511
opening, 72

events
defined, 511
changing to appointments, 72
creating, 72, 176
recurring, 177

Exchange ActiveSync support, 7
Exchange Server accounts, 9

Cached Exchange mode, configuring, 485
configuring, 15
connecting to, 18
encrypted connection problems, 20
MailTips, configuring, 412
rules, creating, 451
synchronizing calendars with, 177
troubleshooting, 20

expanding
contact groups, 330
conversations, 233, 235, 414
Folder Pane, 398
groups, 240, 242
ribbon, 428

Export Outlook Data File wizard, 322
exporting

appointments, by email, 290
contact records, 315, 320
digital IDs, 469
files, 32

extensions. See file types
external content, blocking, 476
external content, downloading, 108

F
Favorites list, adding folders to, 46
Favorites, Public Folder, 484
Field Chooser, 154
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fields
arrows for displaying related information, 78
saving information in, 75

file attachments. See attachments
file types, displaying, 107
Filter dialog box, 322
filtering. See also rules

defined, 511
contact records, 151, 321
messages, 242

finding. See searching
First Time Setup dialog box, 259
Flag Message dialog box, 449
flagging email messages for follow-up, 202, 204, 391

Quick Steps for, 449
flags

deleting items with, 213
removing from items, 213

flowcharts
creating, 383
symbols, inserting, 364

Folder List
defined, 511
address books in, 137
displaying, 47

Folder Pane, 6, 40
defined, 511
content of, 46
customizing, 398, 399
default folders in, 46
Folder List view, displaying, 47
minimizing/expanding, 398, 399

folders. See also public folders
adding to Favorites list, 46
creating, 254, 255, 311
creating as address books, 137
default, setting, 423
importing contact records to, 317
managing, 50
moving messages into, 256
organizing messages with, 253
Search Folders, setting up, 264

searching, 262
selecting location for, 255
structuring, 253

font colors, 340, 346, 357, 359
Font dialog box, 59, 60, 356, 357
font size, in Reading Pane, 112
fonts

changing, 59, 348, 356
changing style, 353
default, 346, 355
location on computer, 356
for message replies, setting, 357
previewing, 356
selecting for printing, 270

footers. See headers and footers
foreign languages. See languages
Format Text Effects dialog box, 61
formatting email messages, 414
formatting pictures, 362, 364, 371

SmartArt graphics as, 384
formatting tables, 100, 101
formatting text, 59, 94

in automatic replies, 493
as bulleted lists, 98
with character spacing, 60
clearing all formatting, 64
with colors, 61
configuring preferences for, 346
in contact records, 77
with font effects, 60, 61
manually, 352
in messages, 54
with shadows, 62
in signatures, 359
with styles and style sets, 350, 351
with themes, 349
undoing effects, 64

forms
accessing form libraries, 442
creating, 442
saving, 442
Standard Forms library, 442
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forwarding email messages, 124, 128, 258
as attachments, 410
closing original messages, 125
configuring options for, 410
preventing, 393, 475
setting signature for, 94

forwarding task requests, 217
free/busy time, 168, 171

checking, 181, 187
sharing, 294

G
galleries, defined, 511
geometric shapes, inserting, 364
Global Address List (GAL), 92, 138

defined, 511
Cached Exchange Mode downloading of, 486
displaying, 310

graphics. See charts; pictures; SmartArt graphics
group schedules, importing, 426
grouping

by category, 247, 250
messages, 239, 240, 241
tasks, 224

groups, contacts. See contact groups
groups, ribbon, 436

defined, 511
adding commands to, 436
adding to tabs, 437
removing, 437

H
headers. See message headers
headers and footers, printing messages with, 272
Help button, 33

defined, 512
Help system, 33

displaying Help window, 33, 34
related information, displaying, 36
searching, 35

hiding
buttons on ribbon, 28
calendar events from other users, 171
calendars, 282, 286
Daily Task List, 277
Mini Toolbar, 99
People Pane, 399
ribbon, 428
To-Do Bar, 399

holidays
adding to calendar, 174, 415
removing from calendar, 175

Hotmail accounts, connecting to, 7
HTML email messages, 93

defined, 511
HTTP protocol, defined, 511
hyperlinks

defined, 511
in notes, adding, 252

I
iCalendar format (ICS) files, 284. See also calendars
ignoring conversations, 236
images. See charts; pictures; SmartArt graphics
IMAP accounts

defined, 511
configuring, 22
troubleshooting, 21

Import And Export wizard, 316
starting, 424

importance
grouping messages by, 239
marking, 53
setting, 391

importing
contact records, 315
contact records, mapping fields when, 318
digital IDs, 469
external data, 315
files, 32
group schedules, 426
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importing (continued)
Internet calendars, 285
SharePoint contact lists, 503

importing/exporting, discontinuation of, 8
Inbox

displaying, 312
organizing with folders, 253
viewing messages in, 108

Inbox folder, 46
indenting

conversations, 235
paragraphs, 353

Indexing Options dialog box, 420
indexing scope for search, configuring, 420
InfoBar, defined, 511
InfoPath forms, 414
information bar, defined, 511
Information Rights Management (IRM), 475

defined, 511
inline email message replies, 6
Insert Chart dialog box, 381
Insert Pictures window, 363
inserting items into email messages, 54
installing

add-ins, 441
digital certificates, 20
Outlook updates, 19

instant messages (IMs)
defined, 511
replying to email messages with, 125
sending from contact records, 146

international Outlook options, 426
Internet calendars

accessing, 282
connecting to, 284
displaying, 285
importing, 285
publishing, 290, 295

Internet Message Access Protocol (IMAP). See IMAP 
accounts

inviting attendees to appointments, 70

J
Junk E-Mail folder, 46
junk email messages

defined, 512
blocking, 459
blocking from specific countries, 466
blocking senders of, 465
checking status of, 460
deleting, 461
deleting automatically, 464
displaying in Junk E-mail folder, 459
graphic disabling for, 460
marking as not junk, 462
moving out of Junk E-mail folder, 461, 462
protection level, setting, 463
replying to, 461
settings for, managing, 463

Junk E-mail Options dialog box, 463
justifying text, defined, 512

K
keyboard shortcuts

defined, 512
for accessing send/receive groups, 486
for address resolution, 89
for categories, 245, 249
for clearing search results, 268
for collapsing ribbon, 64
for creating appointments, 70
for creating contact records, 77
for creating folders, 255
for creating messages, 57
for creating Search Folders, 264
for creating tasks, 84
for deleting categories, 250
for deleting messages, 265
for displaying calendar in Month  

arrangement, 196
for displaying Calendar module, 70
for displaying Contacts module, 77
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for displaying Folder List view, 47
for expanding searches, 267
for ignoring conversations, 236
for marking messages as read/unread, 244
for moving to search box, 151
for redoing editing, 373
for saving draft messages, 94
for searching, 266, 332
for sending messages, 102
for switching calendars to Schedule View, 288
for switching calendars to Work Week  

arrangement, 193
for switching modules, 44
for undoing editing, 373

L
language packs, installing, 421
languages

adding content indexes for, 73
configuring options for, 421

List view, 151
list views

for calendars, 189
removing columns from, 155

Live Preview, 30
defined, 512
for tables, 99

logon credentials, requiring, 18
Lync Meeting group in Calendar module, 66

M
magnification

adjusting, 27
in Reading Pane, 112

Mail module
calendars, displaying/hiding, 283
configuring, 404
Folder Pane, 46
message windows, 50
overview of, 45

ribbon in, 49
tabs in, 49

mailboxes, multiple, 17
mailing addresses for contacts, setting, 139
MailTips, 331

configuring, 412
manually configuring email accounts, 14
Map Custom Fields dialog box, 318
mapping contact locations, 147
mapping fields when importing, 318
marketing information, blocking, 476
marking email messages 

for follow-up, 53
as not junk, 462
as read/unread, 244, 408

marking tasks as complete, 202, 205, 212
mathematical operators, inserting, 364
Maximize/Restore Down button, 26
maximizing the program window, 31
meeting attendees

adding, 181, 183
marking as optional, 180, 184

meeting requests
defined, 512
accepting automatically, 417
checking availability for, 187
configuring options for, 411
creating, 70, 123
creating, from contact records, 146
editing, 185
replying to, 126
responding to, 186, 188
schedules, checking, 71
sending, 179
tracking responses to, 182

meeting windows, 68, 179
defined, 512
Scheduling Assistant, 180

meetings
attendees, adding, 181, 183
attendees, marking as optional, 180, 184
canceling, 185
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meetings (continued)
changing time and duration, 182, 184
configuring options for, 415
creating, 172, 182
editing, 185
Room Finder, 180
scheduling, 178
time zones, specifying, 281
viewing, 184

memos
printing contact records as, 157, 163
printing emails as, 270

message body, 52, 56, 88
message composition windows, 51

commands in, 53
message headers, 52, 56

defined, 512
downloading with Cached Exchange Mode, 489
From button in, 104
icons in, 108

message list, 6
defined, 512
columns, adding and removing, 240
icons in, 49
views for, 108

message participants
contact cards, viewing, 119
creating contact records for, 147
presence icons for, 119
recent interactions, viewing, 122
viewing in People Pane, 121

message reading windows, 55
message recipients

adding from address books, 148
editing before replying, 124

message windows, 50
defined, 512
opening, 95

messages. See email messages; instant  
messages (IMs)

Microsoft Office Clipboard, 58

Microsoft OneNote 2013, creating entries from 
contact records, 147

Microsoft Outlook 2013. See Outlook 2013
Microsoft Outlook dialog box, 499
Microsoft Outlook Help button, 26, 33
Microsoft SharePoint. See SharePoint
Minimize button, 26
minimizing

Folder Pane, 398, 399
ribbon, 428

Mini Toolbar, 59
displaying when selecting text, 404
hiding, 99

module preview, 7
modules, 24

displaying, 44
keyboard shortcuts for switching between, 44
peeking at, 44

months, changing display of, 192
mouse pointer, changing shape as notification, 106
moving

contact records, 313
conversations, 257
messages, 256, 258, 455
Quick Access Toolbar, 427, 428, 432
text, between Office programs, 355

N
naming

categories, 245, 249
digital certificates, 470
email accounts, 16

Navigation Bar, 6, 42
defined, 512
compact, 42
configuring, 422
customizing, 42, 43, 399
resizing, 42
standard, 42

Navigation Options dialog box, 43
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Navigation Pane. See Folder Pane
New Column dialog box, 156
new features in Outlook 2013, 6
New Search Folder dialog box, 264
non-Latin/non-English characters, allowing, 426
Normal view, 40, 48

of Calendar module, 65
of People module, 73
in Tasks module, 81

notes
colors, changing, 252
creating, 253
creating tasks from, 202
hyperlinks, adding to, 252
recording information in, 252, 253
searching, 252

Notes module, accessing, 252
notifications, 102, 106. See also desktop alerts

configuring, 106, 409
for message delivery, 413

O
Office 365, 5
offline address books

defined, 512
configuring, 486
manually updating, 489

offline help, 34
offline mode, 479. See also Cached Exchange Mode

configuring, 425
for SharePoint document libraries, 499
for SharePoint documents, 502
status indicator, viewing, 481
switching out of, 481
switching to, 49, 481

OneNote, creating entries from contact records, 147
online pictures, 363
Open & Export page of Backstage view, 315
opening

appointments, 170

attachments, 110
contact cards, 141
contact records, 337
messages, 109, 118
task windows, 207
Tasks module, 206

optional meeting attendees, 180, 184
organizing tasks, 226
Outbox folder, 47
Outlook 2010, upgrading from, 6
Outlook 2013

client application vs. Web App, 5
configuring, 12
in enterprise environment, 3
features discontinued in, 7
features, new, 6
functions of, 4
help with, 33
starting, 12

Outlook Anywhere, 9
Outlook data files, 10

exporting to, 320
importing, 315
password protecting, 322

Outlook forms. See forms
Outlook Help button, defined, 512
Outlook notes. See notes
Outlook Options dialog box, 278, 403

Mail page, 106
Outlook Options window, 33
Outlook Today 

defined, 512
displaying, 220

Outlook Web App (OWA), 5
Out of Office Assistant. See automatically replying 

to email messages
out-of-office messages, 491. See also automatically 

replying to email messages
Overlay Mode, viewing calendars in, 286, 287
Overtype mode, activating/deactivating, 406
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P
page setup, changing, 160, 270
Page Setup dialog box, 160, 271, 302
paper options when printing, 271
paragraphs

selecting, 58
spacing, 353
styles, applying, 350, 353

passwords
entering, 13
for Outlook data files, setting, 322
setting up, 18

Paste Options button, 406, 414
peeking at modules, 44
peeks, docking, 44, 400
People module. See also contact records

defined, 512
address books, displaying, 310
configuring, 418
contact record windows, 75
content of, 73
displaying, 73, 77, 313
ribbon in, 74
view options for, 150

People Pane, 52, 56, 121
customizing, 398
detailed view, enabling, 123
displaying/hiding, 399

People peek, defined, 512
People view, 150
permissions

defined, 512
for calendars, setting, 291
for public folders, setting, 483
restricting for messages, 393
setting, 475

Personal Forms library, 442
Personal Store (PST) files, 8. See also Outlook  

data files
personalizing email messages, 93
phishing messages

defined, 512

avoiding, 459
blocking, 459

phishing sites, defined, 513
phone directories, printing contacts as, 157
Phone view, 150
photographs. See pictures
Picture Styles gallery, 378
pictures

adding to contact records, 338
artistic effects, adding, 379
aspect ratio, cropping to, 375
backgrounds, removing, 372
cropping, 373
file formats for, 364
formatting, 362, 364, 371
inserting, 361, 362, 369
online, inserting, 361, 363
replying to messages with, 377
resizing, 107, 371
searching Internet for, 363
selecting, 363
sending, 107
styles, applying, 378
text flow, changing, 362

pinning peeks to To-Do Bar, 401
pinning the ribbon, 28
Plain Text format

defined, 513
messages, 93
sending/receiving, 475

pointing, defined, 513
Policy Tips, 413
POP accounts

configuring, 22
connecting to, 9
message retention with, 22
problems on public networks, 23
troubleshooting, 21

popping out email message replies, 99
Post Office Protocol (POP), defined, 513. See also POP 

accounts
PowerPoint presentations, previewing, 116
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presence icons, 119
defined, 513

Preview view for calendars, 189, 196
previewing

attachments, 109, 115, 116
calendars, 196, 298, 300, 303
contact records, 159, 161
document library contents, 502
fonts, 356
messages, 41, 108, 109, 114, 269, 402
multiple pages before printing, 271
SmartArt graphics, 383
style sets, 351
styles, 351
tasks, 207

Print dialog box, 160, 163, 269, 299
Print page of Backstage view, 158, 269
print styles, defined, 513
printing

calendars, 297
changing page setup when, 160
contact records, 157
messages, 268, 272
help information, 34
options for, 33
paper options, 271
preventing, 393, 475
previewing multiple pages before, 271
from Quick Access Toolbar, 427
task lists, 302
work weeks, 302

process diagrams, creating, 383
profiles, creating, 10
program icon, 25
program window, 40

elements of, 25, 40
maximizing, 31
personalizing, 398
streamlining, 111

proofing options, 405
Properties dialog box, 392
Propose New Time dialog box, 188

proposing new meeting times, 186, 188
.pst files. See Outlook data files; Personal Store  

(PST) files
public folders

accessing, 482
adding to contact groups, 327
creating, 483
Favorites, 484
permissions, assigning, 483
searching, 263

public networks, POP email accounts and, 23
publishing calendars to Internet, 290, 295

Q
Quick Access Toolbar, 25

defined, 513
adding commands to, 30, 52, 427, 430
configuring, 427
customizing, 25, 26
in message composition windows, 52
in message reading windows, 56
moving, 427, 428, 432
moving commands on, 431
printing from, 427
resetting, 428, 433
separators, adding, 431
in task windows, 83

Quick Click category
assigning, 247
designating, 246

Quick Steps
defined, 513
actions, adding to, 447
activating, 450
built-in, 258
creating, 446
deleting actions from, 449
editing, 260, 446
for flagging messages for follow-up, 449
keyboard shortcuts for, setting, 449
managing, 446
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Quick Steps (continued)
managing messages with, 257, 455
setting up, 259
tooltips for, creating, 449

R
read receipt requests, 392, 413
reading email messages, 55
Reading Pane, 41, 51

changing font size in, 112
configuring, 408, 422
customizing, 398, 399
displaying/hiding, 49, 112, 221
marking messages as read in, 408
moving, 402
Single Key Reading, configuring, 408
viewing messages in, 115
viewing tasks in, 207

Reading Pane dialog box, 408
Reading view, 40, 48, 111

of Calendar module, 65
of People module, 73
in Tasks module, 81

rebuilding the search index, 420
recalling email messages, 130

defined, 513
receiving email messages, notifications for, 102, 106
recipients

adding to Safe Recipients list, 462, 465
grouping messages by, 239
multiple, addressing to, 91
separating with commas, 411

reclaiming declined tasks, 216
recurring items

defined, 513
appointments, 169, 172
events, 177
tasks, 201, 213

redoing editing, 373

redundant email messages
defined, 513
deleting, 409

religious holidays
adding to calendar, 174
removing from calendar, 175

reminders
defined, 513
for calendar items, 168, 171
configuring, 424
displaying on status bar, 439
for tasks, setting, 201, 208

renaming ribbon tabs, 436
repeating searches, 333
replying to email messages, 123, 127

auto-filling recipient name, 89
automatically, 479, 491
closing original messages after, 125
configuring options for, 410
with embedded pictures, 377
etiquette for, 125
fonts, setting for, 357
inline, 6
with instant messages (IMs), 125
from Junk E-mail folder, 461
with meeting requests, 123
with Quick Steps, 258
in Reading Pane, 51
sending to all recipients, 123
setting signature for, 94
signatures for, 354

resending email messages, 130
defined, 513

resetting
business cards, 341
calendar view, 197
Quick Access Toolbar, 428, 433
ribbon, 438
views, 155, 225, 243

resizing
Folder Pane, 398
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Navigation Bar, 42
pictures, 107, 371
SmartArt graphics, 386
To-Do Bar, 398

resolution. See screen resolution
resolving

defined, 513
email addresses, 15, 53, 89, 148, 411

resources
adding to contact groups, 327
inviting to meetings, 180, 184
searching, 334

responding to meeting requests, 186, 188
reviewing email message content, 55
ribbon, 26

defined, 513
in Calendar module, 66
collapsing, 28, 64
customizing, 433, 435
customizing display, 399
dynamic sizing of, 30
expanding, 401, 428
groups, adding, 436
hidden groups, displaying, 30
hiding, 428
in Mail module, 49
in message composition windows, 52
in message reading windows, 56
overview of, 27
in People module, 74
pinning, 28
resetting, 438
tabs, adding, 435
tabs on, 27, 29
in Tasks module, 82
tool tabs, 29
unpinning, 28
width of, 31

Ribbon Display Options button, 26
Rich Text Format (RTF)

defined, 513
messages, 93

Room Finder, 70, 180
RPC over HTTP. See Outlook Anywhere
RSS Feeds folder, 47, 425
RSS feeds, subscribing to, 425
RTF. See Rich Text Format (RTF)
rules

defined, 513
for automatic replies, 491, 495
creating, 451, 452
descriptions, editing, 454
editing, 453, 496
exceptions, adding, 456
managing, 32
running on existing messages, 457
selecting account to apply to, 452
setting up for Exchange Server accounts, 451
specifying actions for, 455
templates, creating from, 453

Rules And Alerts dialog box, 452, 455, 457
Rules wizard, 453
running rules on existing email messages, 457

S
Safe Senders list, adding to, 462, 464
saving

appointments, 173
attachments, 110
business cards, 342
contact groups, 329
contact records, 141
drafts, 411
forms, 442
messages, 94, 95, 410
tasks, 208, 211

Schedule View, displaying calendars in, 288
Scheduling Assistant

configuring, 416
meeting window page, 180

scheduling attendees for meetings, 71
scheduling windows, 68
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screen clippings, 367
defined, 514
capturing and inserting, 366

screen magnification, changing, 31. See also zooming 
in and out

screen resolution, changing, 31
screenshots. See screen clippings
ScreenTips

defined, 514
configuring, 404
displaying, 28, 33
displaying keyboard shortcuts in, 406

Search Folders, 47, 264
modifying, 265

Search Text dialog box, 455
Search tool tab, 262, 266
searching

address books, 310
canceling current search, 334
clearing results of, 268
configuring options for, 419
contact records, 151, 332
conversations, 237
criteria, adding/removing, 334
criteria, changing, 263, 267
file properties, 263
filtering when, 332
folders, 262
Help system, 35
indexing scope, configuring, 420
keyboard shortcut for, 332
message content, 262, 266
notes, 252
overview of, 262
public folders, 263
repeating previous searches, 333
scope of, expanding, 333
for tasks, 226

securing email messages, 467
by blocking external content, 476
with digital signatures, 467

with encryption, 474
with Information Rights Management (IRM), 

475
security

add-ins, issues with, 441
policies, avoiding violations, 413

Security Properties dialog box, 473
selecting

appointments, 170
calendar items, 192
contact records, 162, 313
messages, 236
pictures, 363

selecting text, 58
configuring options for, 406
displaying Mini Toolbar when, 404

Select Members dialog box, 326
Select Name dialog box, 148, 149
semicolons, separating recipients with, 91
Send A Calendar Via E-Mail dialog box, 295
Send button, 95
send/receive groups, defining, 486
Send/Receive Groups dialog box, 425, 487
Send/Receive tab, 490
senders

adding to Safe Senders list, 462, 464
blocking, 465
grouping messages by, 239, 241

sending email messages, 95, 102
to address book contacts, 148
configuring options for, 404, 411
to contact groups, 330
to multiple recipients, 91, 411
using Quick Steps, 258, 446
selecting account when, 104

sensitivity, setting, 391, 404
Sent Items folder, 46, 95

displaying, 103, 234
separated text files, defined, 514
separators, adding to Quick Access Toolbar, 431
server certificates, error messages, 20
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server ports, POP mail and, 23
server rules, defined, 514
shadows, applying to text, 62
shapes

creating, 386
inserting, 364

shared calendars, 282
shared folders, activating Cached Exchange Mode 

for, 486
SharePoint, 479, 498

calendars, accessing, 282
calendars, connecting to, 505
contact lists, importing, 503
document libraries, connecting to other 

computers, 500
document libraries, connecting to Outlook, 499
document libraries, updating subscriptions  

to, 500
document libraries, working offline, 499
document library subfolders, 501
editing files offline, 502
drafts, working with, 502
granting permission to, 499
libraries, adding to contact groups, 327
opening files offline, 502
previewing document library contents, 502

SharePoint List Options dialog box, 500
SharePoint Lists folder, 501
sharing

calendars, 290, 294
free/busy time, 294

sharing invitations, 290
shortcut menus, defined, 514
Show Columns dialog box, 240
Side-By-Side Mode, viewing calendars in, 287
signatures. See also digital signatures

business cards, including in, 336, 359
configuring, 353
creating, 355, 358
creating multiple, 354
deleting, 355

editing, 359
for email accounts, 355
formatting, 359
inserting, 355
setting, for replies and forwards, 94

Signatures And Stationery dialog box, 346, 357, 358
Simple List view, 222

displaying, 223
Single Key Reading, configuring, 408
Single view, switching to, 114
site mailboxes, accessing, 7
sizing handles, defined, 514
slow Internet connections, configuring Cached 

Exchange Mode for, 489
small caps, applying, 60
smart cut and paste, 406
SmartArt graphics

defined, 514
adding shapes to, 386
colors, changing, 388
copying and reusing, 389
creating, 381, 383
formatting, 384
layouts, changing, 386
previewing, 383
sizing, 386
styles, applying, 388
Text pane, displaying/hiding, 384

S/MIME protocol
defined, 514
digital IDs, obtaining, 469
receipts, requesting, 474

sorting
contact records, 153
messages, 240, 241
tasks, 223

spam. See junk email messages
spelling and grammar checking settings, 405
splitting conversations, 233
Standard Forms library, 442
start dates, grouping messages by, 239
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starting Outlook, 12
stationery

applying to messages, 347
fonts with, selecting, 348

status bar, 26
defined, 514
customizing, 439
indicators on, 26

status reports, on assigned tasks, 214, 217
sticky notes. See notes
style sets, 351
styles

applying, 350
for pictures, applying, 378
previewing, 351
for SmartArt graphics, applying, 388

subject line of email messages, 88
subjects

grouping messages by, 239, 242
rules, creating for, 455

subscribing to Internet calendars, 285
swapping time zones, 281
synchronizing Outlook, 66, 480

calendar reminders and, 168
configuring, 425

T
tab-separated text files, importing from, 315
tables

entering information in, 100
formatting, 100, 101
inserting, 99
previewing, 99
printing contact records as, 163
printing contacts as, 157

tabs, ribbon, 27, 29
defined, 514
adding, 435
adding groups to, 437
customizing, 434
renaming, 436

task folders, creating, 226
task lists

defined, 514
displaying, 189, 194
marking items as complete, 205
printing, 302
transferring messages to, 202, 205

task originators, defined, 514
task owners, defined, 514
task requests

accepting or declining, 216
forwarding, 217
sending, 214, 215, 218

task windows, 83
defined, 514
fields in, 84
opening, 207

tasks
arrangements for, 222
arranging, 223
assigning, 147, 214, 217, 218
categories, assigning, 201, 226
configuring options for, 418
creating, 84, 200, 201
creating, from Outlook items, 202
custom flags, setting, 207
deleting, 202, 213
displaying, 219
displaying details for, 84
displaying on To-Do Bar, 219
dragging to calendar, 220
due dates, assigning, 84, 206, 418
due dates, changing, 210
editing, 210
entering information for, 208
fields, modifying, 222
grouping, 224
marking as complete, 202, 212
marking as private, 201
opening, 207
organizing, 226
previewing, 207
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priority, setting, 201
reclaiming declined, 216
recurring, 201
reminders, configuring, 424
reminders, setting, 201, 208
replying to, 126
saving and closing, 208, 211
scheduling, 168
searching for, 226
sorting, 223
status, changing, 210, 212
status reports on assigned, 217
status, tracking, 201
updating, 210
views, changing, 223
working with, 83

Tasks folder
displaying, 219
views for, 222

Tasks module
defined, 514
configuring, 418
content of, 81
displaying, 81, 84, 203
opening, 206
ribbon in, 82
task windows, 83
views for, 219

Tasks peek, defined, 514
Tasks view, defined, 514
Team Email Quick Step, 258
text. See also formatting text

effects, 61, 353
selecting, 58

text email messages. See Plain Text format
text files, importing from, 315
text flow around pictures, changing, 362
Theme Effects gallery, 349
Theme Or Stationery dialog box, 347
themes

applying, 347, 349

colors, applying, 357
configuring, 404
default Office theme, 349
modifying, 349
for Office documents, 350

third-party add-ins, defined, 514
threads, defined, 514. See also conversations
thumbnail galleries, 29
thumbnails, defined, 515
time zones

configuring, 280, 416
displaying multiple, 281
setting for calendar events, 72
specifying for appointments, 281
swapping, 281

title bar, 25
defined, 515

To-Do Bar, 42
defined, 515
arranging items on, 204
customizing, 398
hiding, 399
pinning module peeks to, 219, 401
resizing, 398
separators, moving, 401

To-Do List
displaying, 84, 219
displaying, 219
views for, 221

To-Do List view
defined, 515
displaying, 225

tool tabs, 29
defined, 515

tooltips, creating for Quick Steps, 449
touch-enabled devices, adapting exercises for, 11
tracking

assigned tasks, 214
changes, 406
configuring options for, 413
messages, 392
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tri-fold calendars, printing, 297, 304
troubleshooting

connection problems, 20
Conversation view, 237

Trust Center dialog box, 468, 469
type, grouping messages by, 239

U
undoing editing, 64, 373
Uniform Resource Locators (URLs), defined, 515
unique email messages, defined, 515
unpinning the ribbon, 28
unread email messages

displaying, 109, 243
marking, 244
viewing in Search Folder, 264

updates, installing, 19
updating

offline address books, 489
tasks, 210

URLs. See Uniform Resource Locators (URLs)
user information, specifying, 404
user interface, overview, 24
UTF-8 support, configuring, 426

V
validating email addresses. See resolving
verifying names and addresses, 147
View Shortcuts toolbar, 27

defined, 515
viewing conversations, 112
views

defined, 515
accessing gallery of, 221
in Calendar module, 189
changing, 196, 223
customizing, 40, 50
personalizing, 151
resetting, 155, 225, 243
switching between, 40

VoIP calls, initiating, 125
voting buttons, 127

adding to messages, 391

W
Weather Bar, 7, 417
weather, displaying in calendars, 417
Web App. See Outlook Web App (OWA)
web beacons, 460

defined, 515
blocking, 476

websites, opening from contact records, 80, 146
Windows Security dialog box, 472
Windows Taskbar, Outlook notification icon, 106
Word documents. See also attachments

sending by email, 103
work week

defined, 515
appearance in calendar, 276
defining, 276, 278, 415
displaying, 190, 193, 277
printing, 302

working offline. See offline mode
writing email messages. See creating email messages

Z
Zoom dialog box, 113
zooming in and out, 27

of calendars, 288
in Reading Pane, 112

556      tri-fold calendars, printing
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